Getting Started with Digi 002 & Digi 002 Rack

Version 6.7 for LE Systems on Windows or Macintosh
Communications & Safety Regulation Information

Compliance Statement
The model Digi 002 complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN55022
• EN55024
• AS/NZS 3548 Class B
• CISPR 22 Class B

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.

DECLARATION OF CONFORMITY
We Digidesign,
3401-A Hillview Avenue
Palo Alto, California 94304-1348, USA
650-842-7900
declare under our sole responsibility that the product
Digi 002
complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Canadian Compliance Statement:
This Class B digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada

Australian Compliance

European Compliance
Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specification of UL Standards : UL1419 and Canadian CAN C22.2No.1-98, IEC60950. Digidesign Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning!

Important Safety Instructions
When using electric or electronic equipment, basic precautions should always be followed, including the following:
- Read all instructions before using this equipment.
- To avoid the risk of shock, keep this equipment away from rain water, and other moisture. Do not use this equipment if it is wet.
- The equipment should only be connected to the correct rating power supply as indicated on the product.
- Do not attempt to service the equipment. There are no user-serviceable parts inside. Please refer all servicing to authorized Digidesign personnel.
- Any attempt to service the equipment will expose you to a risk of electric shock, and will void the manufacturer’s warranty.
- The product should be connected only to the correct power supply as indicated on the product.
- Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
- Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
- Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than other, A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
- Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
- Only use attachments/accessories specified by the manufacturer.
- Clean only with dry cloth.
# Contents

## Chapter 1. Welcome to Digi 002 and Digi 002 Rack
- Digi 002 and Digi 002 Rack Packages ............................................. 1
- Digi 002 and Digi 002 Rack Features ............................................... 1
- Pro Tools LE Capabilities ............................................................... 3
- System Requirements ........................................................................ 3
- Digidesign Registration ..................................................................... 5
- About the Pro Tools Guides ............................................................... 5
- About www.digidesign.com ................................................................. 6

## Chapter 2. Windows Configuration ......................................................... 7
- Installation Overview ......................................................................... 7
- Testing Digi 002 .................................................................................. 7
- Windows System Settings .................................................................... 8
- Connecting Digi 002 or Digi 002 Rack to the Computer ...................... 10
- Connecting FireWire Drives ............................................................... 10
- Installing Pro Tools LE ....................................................................... 11
- Optional Software on the Pro Tools Installer CD-ROM ...................... 12
- Launching Pro Tools LE ..................................................................... 14
- Configuring Pro Tools LE ................................................................... 15
- Hard Drive Configuration and Maintenance ..................................... 18
- Removing Pro Tools on Windows XP ................................................ 19
### Chapter 3. Macintosh Configuration

- Installation Overview ........................................... 21
- Testing Digi 002 ..................................................... 21
- Apple System Settings for Mac OS X ........................... 22
- Installing Pro Tools LE ............................................ 22
- Optional Software on the Pro Tools Installer CD-ROM ....... 23
- Connecting Digi 002 or Digi 002 Rack to the Computer .... 24
- Connecting FireWire Drives ....................................... 24
- Launching Pro Tools LE ........................................... 25
- Configuring Pro Tools LE .......................................... 26
- Hard Drive Configuration and Maintenance .................... 30
- Removing Pro Tools on Mac OS X ............................... 30

### Chapter 4. Digi 002 Top Panel

- Digi 002 Operating Modes ........................................ 31
- The Digi 002 Top Panel ........................................... 32
- Fader Section ....................................................... 34
- Console/Channel View Section ................................... 37
- Transport and Navigation Controls .............................. 40
- Mic/Line/Instrument Input Controls ............................. 42
- Monitor Section ..................................................... 42
- Keyboard Modifier Switches ..................................... 43
- Status Indicators and Display Controls ......................... 44

### Chapter 5. The Digi 002 Rack Front Panel

- Mic/Line/Instrument Input Controls ............................. 48
- Monitor Controls ................................................... 48
- Status Indicators ................................................... 49

### Chapter 6. Digi 002 and Digi 002 Rack Back Panels

- ................................................................. 51
## Chapter 7. Connecting Your Studio

- Connecting Digi 002 or Digi 002 Rack to a Computer ........................................... 57
- Monitoring Audio ........................................................................................................ 60
- Connecting Audio Sources to Digi 002 or Digi 002 Rack ......................................... 61
- Using External Effects Devices .................................................................................. 63
- Monitoring and Recording from Alternate Sources .................................................... 64
- Mirroring the Main Outputs .......................................................................................... 65
- Connecting a Recorder for Mixdowns ......................................................................... 66
- MIDI Connections ....................................................................................................... 67

## Chapter 8. Working with Pro Tools LE

- Session Basics ............................................................................................................. 69
- Transport Controls .................................................................................................... 74
- Tracks ............................................................................................................................ 75
- Regions Lists ............................................................................................................... 76
- Navigating in a Session .............................................................................................. 77
- Importing Audio .......................................................................................................... 79
- Basic Recording .......................................................................................................... 81
- Editing .......................................................................................................................... 87
- Mixing .......................................................................................................................... 90
- Plug-Ins ....................................................................................................................... 92
- Mix Automation ......................................................................................................... 93
- Final Mixdown ............................................................................................................ 94

## Chapter 9. Using Digi 002 as a Stand-Alone Mixer

- Overview ..................................................................................................................... 96
- Entering Stand-Alone Mode ....................................................................................... 98
- Digital Audio Connections in Stand-Alone Mode ....................................................... 98
- Views in Stand-Alone Mode ...................................................................................... 100
- Working with Effects ................................................................................................. 106
- Working with Sends ................................................................................................... 108
- Storing Snapshots ..................................................................................................... 110

## Appendix A. Windows System Optimizations

- Troubleshooting .......................................................................................................... 111
- Advanced Settings ..................................................................................................... 111
Appendix B. Digidesign ASIO Driver (Windows Only) ................................................. 113
  Introduction ............................................................................................................ 113
  Compatible Software .............................................................................................. 113
  Installing the ASIO Driver ..................................................................................... 114
  Removing the ASIO Driver .................................................................................... 114
  Configuring ASIO Driver Settings ........................................................................ 114

Appendix C. Digidesign WaveDriver (Windows Only) ................................................. 117
  Introduction ............................................................................................................ 117
  Compatibility .......................................................................................................... 117
  Installing the WaveDriver ..................................................................................... 118
  Removing the WaveDriver .................................................................................... 118
  Configuring WaveDriver for QuickTime Player (Required for Using iTunes) ....... 118
  Configuring WaveDriver for Windows Media Player and Other Third-Party WaveDriver Programs ................................................................. 119
  Adding Third Party Applications to the WaveDriver Opt-In List ......................... 119

Appendix D. Digidesign CoreAudio Driver (Macintosh Only) .............................. 121
  Introduction ............................................................................................................ 121
  What are the Limitations of the Digidesign CoreAudio Driver? ......................... 122
  Compatibility .......................................................................................................... 122
  Installing the CoreAudio Driver ........................................................................... 122
  Removing the CoreAudio Driver .......................................................................... 123
  Configuring the Digidesign CoreAudio Driver ..................................................... 123

Appendix E. Configuring Midi Studio Setup (Windows Only) .............................. 129
  MIDI Studio Setup .................................................................................................. 129
  Patch Name Support .............................................................................................. 131

Appendix F. Configuring AMS (Mac OS X Only) .................................................... 133
  Audio MIDI Setup .................................................................................................. 133
  Patch Name Support .............................................................................................. 136

Appendix G. Digi 002 Stand-Alone Block Diagram ................................................ 137

Index .......................................................................................................................... 141
Welcome to Digi 002 and Digi 002 Rack, Digi-design’s cross-platform Pro Tools workstations for music, sound design, and multimedia production.

## Digi 002 and Digi 002 Rack Packages

The Digi 002 and Digi 002 Rack packages include the following:

- Digi 002 or Digi 002 Rack unit (depending on which product you have purchased)
- Installer CD-ROMs containing Pro Tools LE software, Digirack RTAS (Real-Time Audio-Suite) and AudioSuite plug-ins, and electronic PDF guides
- *Getting Started with Digi 002 & Digi 002 Rack Guide*, covering installation, configuration, and basic tutorials for Digi 002 and Digi 002 Rack
- FireWire cable for connecting the Digi 002 or Digi 002 Rack to a computer
- AC power cable
- Digidesign Registration card

## Digi 002 and Digi 002 Rack Features

### Audio and MIDI Features

(Digi 002 and Digi 002 Rack)

The Digi 002 and Digi 002 Rack units provide the following input and output capacity:

- 8 analog audio inputs (4 with mic preamps), with A/D converters supporting up to 24-bit, 96 kHz audio
- 48V phantom power on mic preamps, switchable in channel pairs
- –10 dBV input pair for direct monitoring of tape or CD input sources
- Eight analog audio outputs, with D/A converters supporting up to 24-bit, 96 kHz audio
- Monitor Output pair (+4 dBu) mirrors Main Outputs 1–2 with dedicated volume control for direct connection to powered speakers
- Alternate Main Output pair (–10 dBV) mirrors Main Outputs 1–2 for direct output to –10 dBV devices.
- Stereo headphone output with level control
- Optical connectors for 8 channels of ADAT I/O (up to 48 kHz) or 2 channels of Optical S/PDIF I/O (up to 96 kHz)
• RCA connectors for 2 channels of S/PDIF digital I/O supporting up to 24-bit, 96 kHz audio
• 1 MIDI In port and 2 MIDI Out ports, providing up to 16 channels of MIDI input and up to 32 channels of MIDI output
• Footswitch jack for punching in and out while recording

Control Surface Features
(Digi 002 Only)

Digi 002 provides an integrated control surface for software control that includes the following:
• Eight touch-sensitive moving faders and dedicated solo, mute and channel select/record arm controls
• Eight multi-function rotary encoders for operating pan, send, and plug-in controls
• Transport and navigation controls
• Ten scribble strips for channel information display

Stand-Alone Mixing Features
(Digi 002 Only)

Digi 002 can be used as a stand-alone 8-channel digital mixer with the following features:
• 8 analog inputs (4 with mic preamps), with dedicated volume, pan, solo and mute controls
• Dedicated three-band EQ available on input channels 1–8
• Dedicated Compressor/Limiter available on input channels 1–4
• Built-in high-quality Reverb and Delay
• Four sends on each input channel:
  • Sends 1–2 dedicated to internal Delay and Reverb effects
  • Sends 3–4 for integrating external effects
• Stereo outputs with dedicated Master Fader controls, including:
  • Main Output pair (+4 dBu fixed signal)
  • Monitor Output pair (+4 dBu) mirrors Main Outputs 1–2 with dedicated volume control for direct connection to powered speakers
  • Alternate Main Output pair (–10 dBV) mirrors Main Outputs 1–2 for direct output to –10 dBV devices
• Stereo headphone output with level control
• Ten scribble strips for pan/volume and effects control, send levels, and track names
• Channel metering available using rotary encoder LED rings (in Meter mode)
Pro Tools LE Capabilities

Pro Tools LE software provides the following capabilities with Digi 002 and Digi 002 Rack:

• Record and play back up to 32 mono digital audio tracks, depending on your computer’s capabilities.

• Sessions can include up to 128 audio tracks (with 32 voiceable tracks maximum), 256 MIDI tracks, 128 Auxiliary Input tracks, and 64 Master Fader tracks.

• 16-bit or 24-bit audio resolution, at sample rates up to 96 kHz

• Nonlinear, random-access editing and mix automation

• Audio processing with up to five RTAS plug-ins per track, depending on your computer’s capabilities

• Up to five inserts and five sends per track

• Up to 16 internal mix busses

⚠️ Pro Tools LE uses your computer’s CPU to mix and process audio tracks (host processing). Computers with faster clock speeds yield higher track counts and more plug-in processing.

System Requirements

Digi 002 and Digi 002 Rack can be used with a Digidesign-qualified Windows or Macintosh computer running Pro Tools LE software.

For complete system requirements, visit the compatibility page of the Digidesign Web site (www.Digidesign.com/compato).

Compatibility Information

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For a list of Digidesign-qualified computers, operating systems, hard drives, and third-party devices, refer to the latest compatibility information on the Digidesign Web site (www.digidesign.com/compato).

MIDI Requirements

USB MIDI interfaces work effectively with Pro Tools systems on Windows or Macintosh. Serial MIDI interfaces are supported on Windows systems only.

⚠️ Only USB MIDI interfaces are compatible with Pro Tools systems for Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

For a list of supported adapters, refer to the Digidesign Web site (www.digidesign.com).
Hard Drive Considerations

Hard Drive Configuration and Maintenance

It is recommended that you start with a newly initialized audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

For a list of qualified hard drives, see our Web site (www.digidesign.com/compato).

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with Windows Disk Management (Windows) or the Disk Utility application included with Apple System software (Macintosh).

Avoid Recording to System Drives

Although Pro Tools LE will let you record to your system drive, this is generally not recommended. Recording and playback on system hard drives results in lower track counts and fewer plug-ins.

Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD-quality) require approximately 5 MB of hard disk space per minute.

The same tracks recorded with 24-bit resolution require about 7.5 MB per minute. Recording at higher sample rates (88.2 kHz or 96 kHz) requires about twice the hard disk space.

Table 2 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

<table>
<thead>
<tr>
<th>Number of tracks and length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
<th>16-bit at 88.2 kHz</th>
<th>16-bit at 96 kHz</th>
<th>24-bit at 88.2 kHz</th>
<th>24-bit at 96 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
<td>10 MB</td>
<td>11 MB</td>
<td>15 MB</td>
<td>16.4 MB</td>
</tr>
<tr>
<td>1 stereo track 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
<td>100 MB</td>
<td>110 MB</td>
<td>150 MB</td>
<td>164 MB</td>
</tr>
<tr>
<td>1 stereo track 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
<td>1.8 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>32 mono tracks 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.4 GB</td>
<td>1.6 GB</td>
<td>1.8 GB</td>
<td>2.4 GB</td>
<td>2.8 GB</td>
</tr>
<tr>
<td>32 mono tracks 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.5 GB</td>
<td>18.8 GB</td>
<td>20.8 GB</td>
<td>28 GB</td>
<td>31 GB</td>
</tr>
</tbody>
</table>
Digidesign Registration

Complete and return the registration card included with Digi 002 or Digi 002 Rack. Registered users will receive periodic software update and upgrade notices. Refer to the registration card for information on technical support.

About the Pro Tools Guides

This Getting Started with Digi 002 & Digi 002 Rack Guide explains how to install and use Digi 002 or Digi 002 Rack to record, edit, and mix audio and MIDI tracks in Pro Tools LE.

If you are new to working with digital workstations, it is recommended that you read the following:

- Digi 002 and Digi 0023 Rack Basics Guide provides simple steps for how to get sound in and out of your Digi 002 or Digi 002 Rack, connect a microphone or instrument, record to a Pro Tools session, import audio from a CD, create an audio CD from a Pro Tools session, and other topics.

For additional information, see the following online guides:

- Pro Tools Menus Guide covers all the Pro Tools on-screen menus.
- DigiRack Plug-Ins Guide explains how to use the RTAS and AudioSuite plug-ins included with Pro Tools LE.
- Digidesign Plug-Ins Guide explains how to use optional Digidesign plug-ins.
- DigiBase Guide provides details on using Pro Tools DigiBase databasing and browsers for data and media management.
- Keyboard Shortcuts lists keyboard shortcuts for Pro Tools LE.

PDF versions of the Pro Tools guides are installed automatically with Pro Tools, and are accessible from the Pro Tools Help menu (Windows) or Pro Tools menu (Mac OS X). To view or print the PDF guides, you can install Acrobat Reader (included on the Pro Tools Installer CD-ROM).

Printed copies of the Pro Tools LE guide set (including the Pro Tools Reference Guide) can be purchased separately from the DigiStore (www.digidesign.com).
**Conventions Used in This Guide**

Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save Session</td>
<td>Choose Save Session from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click (Windows)</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The following symbols are used to highlight important information:

💡 **User Tips** are helpful hints for getting the most from your system.

⚠️ **Important Notices** include information that could affect your data or the performance of your system.

🔍 **Shortcuts** show you useful keyboard or mouse shortcuts.

🔍 **Cross References** point to related sections in other Digidesign guides.

---

**About www.digidesign.com**

The Digidesign Web site (www.digidesign.com) is your best source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Support** Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; join the worldwide Pro Tools community on the Digidesign User Conference.

**Training and Education** Become a certified Pro Tools Operator or Expert; study on your own using courses available online, or find out how you can learn in a classroom setting at a certified Pro Tools Training Center.

**Products and Developers** Learn about Digidesign products; download demo software; learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Digidesign; sign up for a Pro Tools demo.

To learn more about these and other resources available from Digidesign, visit the Digidesign Web site (www.digidesign.com).
This chapter contains information for Windows systems only. If you are installing Pro Tools on a Macintosh computer, see Chapter 3, “Macintosh Configuration.”

⚠️ Before installing this version of Pro Tools, please refer to the Read Me information included on the Pro Tools Installer CD-ROM.

### Installation Overview

Installing the Digi 002 or Digi 002 Rack on a Windows computer includes the following steps:

3. “Connecting Digi 002 or Digi 002 Rack to the Computer” on page 10.
6. Making audio and MIDI connections to the Digi 002 or Digi 002 Rack. (See Chapter 7, “Connecting Your Studio.”)

⚠️ When connecting Digi 002 to your computer the first time, your computer should be off. If your computer is on, power it down.

#### Testing Digi 002

(Digi 002 Only)

Before you install Pro Tools LE software or connect Digi 002 to your computer for the first time, you should power up the unit to be sure it is working correctly.

⚠️ When connecting Digi 002 to your computer the first time, your computer should be off. If your computer is on, power it down.

To set up and test the Digi 002:

1. Plug the Digi 002 into a standard AC receptacle, using the AC power cable included with the unit.

Digi 002 is auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

2. Power on the Digi 002 unit by turning on the power switch on the back panel. After a short power-up sequence, the Channel Scribble Strips on the unit show “Digi 002 Standby,” and the Standalone switch flashes to indicate Standby mode.

3. Press the Standalone switch in the upper right of the top panel of Digi 002. The Channel Scribble Strips on the unit will show “Enter Standalone Mode?”

---

__Chapter 2: Windows Configuration__

7
4 Press the Channel Select switch under “Yes” to enter Stand-alone mode. The Channel Scribble Strips on the unit will show the default names of the channel inputs, “In1” through “In8.”

5 To return Digi 002 to Standby mode, press the Standalone switch a second time. The Channel Scribble Strips on the unit will show “Exit Standalone Mode?”

6 Press the Channel Select switch under “Yes” to return to Standby mode.

---

**Windows System Settings**

Configure your Window system settings, as follows:

**Required Settings** These instructions must be followed before installing Pro Tools.

**Recommended Configuration** These instructions should be followed to optimize your system’s capabilities, or to let older computers run Pro Tools LE.

⚠️ If problems occur after configuring all required and required settings, see Appendix A, “Windows System Optimizations (Windows Only)” for information on troubleshooting and configuring advanced settings.

**Required Settings**

To ensure optimum performance with Pro Tools LE, configure the following Control Panel settings for your version of Windows XP.

---

**Disable Hyper-Threading**

For Pentium IV computers with Hyper-Threading, disable Hyper-Threading in the BIOS.

Refer to your computer’s documentation for steps on how to enter your computer’s BIOS and disable Hyper-Threading.

**Enable DMA**

Enabling your computer’s DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows XP detects and activates DMA mode by default.

**Enable DMA for any IDE hard drives:**

1. Choose Start > Control Panel.
2. Launch System.
3. Click the Hardware tab.
4. Under Device Manager, choose Device Manager.
5. In the Device Manager window, double-click IDE ATA/ATAPI controllers, then double-click the Primary IDE Channel for your IDE hard drive.
6. Click the Advanced Settings tab.
7. For each device, set the Transfer Mode to “DMA if available,” and click OK.

In most cases, this will already be set correctly as Windows XP will detect and activate DMA mode by default.

8. Repeat steps 5–7 for any additional IDE Channels.
Disable System Standby and Power Management

When using Pro Tools, the Windows System Standby power scheme must be set to Always On. This helps prevent long record or playback passes from stopping due to system resources powering down.

To configure Windows Power Management:
1. Choose Start > Control Panel.
2. Launch Power Options.
3. Click the Power Schemes tab.
4. From the Power Schemes pop-up menu, select Always On.
5. Click OK.

This sets System Standby, System Hibernate, and “Turn off hard disks” to Never.

Disable ClearType Font Smoothing

When using Pro Tools, the Effects “Clear Type” setting must be disabled.

To disable ClearType font smoothing:
1. Choose Start > Control Panel.
2. Launch Display.
3. Click the Appearance tab.
4. Click Effects.
5. Deselect “Use the following methods to smooth edges of screen fonts.”
6. Click OK to save your settings and close the Effects dialog.
7. Click OK.

Completing Required Windows System Settings

When finished updating required Windows system settings, restart your computer.

Recommended Configuration

Pro Tools LE can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you:

- Avoid running other Windows programs at the same time as Pro Tools LE.
- Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
- Turn off any non-essential USB devices while using Digi 002 or Digi 002 Rack.
- If your video display card supports it, enable Bus Mastering in the manufacturer’s Control Panel.
- Disable any networking cards (other than any 1394 “FireWire” card that you might use to connect an external drive to your system).

For information on disabling networking cards, see “Disabling Network Cards” on page 111.
Connecting Digi 002 or Digi 002 Rack to the Computer

Before installing Pro Tools LE software and the Digi 002 or Digi 002 Rack software, you need to connect Digi 002 or Digi 002 Rack to the computer.

⚠️ When connecting Digi 002 or Digi 002 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.

To connect the Digi 002 or Digi 002 Rack to your computer:

1. Plug the Digi 002 or Digi 002 Rack into a standard AC receptacle, using the AC power cable included with the unit.

Digi 002 and Digi 002 Rack are auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

2. Power on the unit by toggling the power switch on the back panel (Digi 002), or pressing the power switch on the front panel (Digi 002 Rack). After a short power-up sequence the Sample Rate LED and Monitor Mute switch illuminate to indicate the unit is on.

3. Locate the FireWire cable that came with your unit.

4. Plug one end of the FireWire cable into one of the ports marked “1394” on the back panel of the Digi 002 or Digi 002 Rack. Either port will work.

5. Do one of the following, depending on your system configuration:
   - Plug the other end of the FireWire cable into an available FireWire port on your computer.
   - Plug the other end of the cable into an available FireWire port on a FireWire hard drive connected to your computer. (See “Connecting FireWire Drives” on page 10.)

Connecting FireWire Drives

Connect FireWire hard drives directly to a FireWire port on your computer. Do not connect a FireWire hard drive to the second FireWire port on the back panel of Digi 002 or Digi 002 Rack because the FireWire ports do not pass audio data when the unit is powered off.

To connect a FireWire hard drive:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on the computer, and connect Digi 002 or Digi 002 Rack to another FireWire port on the computer.
  – or –
If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect Digi 002 or Digi 002 Rack to an available FireWire port on the drive.

⚠️ While it is possible to connect a FireWire hard drive to an available port on Digi 002 or Digi 002 Rack, if the unit is powered off, any mounted FireWire drives will lose their data connection with the computer. This may result in hard drive errors or data loss.

4-Pin FireWire Cable

Digi 002 and Digi 002 Rack include a 6-pin to 6-pin FireWire cable. Some Windows laptops include a 4-pin FireWire port. To use Digi 002 or Digi 002 Rack with these computers, a 4-pin to 6-pin cable is required. Purchase this cable (model #CS625) through your authorized Digidesign dealer or online through the DigiStore (www.digidesign.com).

⚠️ This cable can also be purchased at computer supply stores. Maximum supported cable length for FireWire (IEEE-1394) is 14 feet (4.3 meters).

Connecting Other FireWire Devices to Digi 002 or Digi 002 Rack

The second FireWire port on the Digi 002 or Digi 002 Rack unit is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, Digi 002 or Digi 002 Rack supplies power from the computer through its FireWire ports, letting you recharge batteries in other FireWire devices.

Installing Pro Tools LE

To install Pro Tools LE on Windows:

1. Make sure you have configured all the required Windows system settings, and rebooted your computer. See “Windows System Settings” on page 8 for more information.

2. Start up Windows, logging in with Administrator privileges. If you do not have Administrator privileges or do not know how to set them up, see your Windows User’s Guide.


4. Insert the Pro Tools Installer CD-ROM for Windows in your CD-ROM drive. Locate and open the Pro Tools Installer folder, and double-click the Setup icon.

5. Click Next to begin installation.

6. Select the components you want to install and click Next.

⚠️ If you get a warning dialog about the driver not passing Windows Logo testing, click Continue Anyway.

7. Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

8. Click Quit when prompted to install QuickTime. If required, you can install QuickTime later (see “Installing QuickTime” on page 12).

9. Restart your computer.
MIDI Studio Setup
(Optional)

If you plan to use any MIDI devices with Pro Tools, configure your MIDI setup with MIDI Studio Setup. See Appendix E, “Configuring Midi Studio Setup (Windows Only)” for details.

Installing QuickTime
(Optional)

QuickTime 6.5 or later is required for Pro Tools LE if you plan to include movie files in your sessions. QuickTime is available as a free download from the Apple Web site (www.apple.com).

Optional Software on the Pro Tools Installer CD-ROM

Your Pro Tools Installer CD-ROM includes several software options.

Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Output) Driver is a single-client multichannel sound driver that allows third-party audio programs that support the ASIO standard to record and play back through Digidesign hardware.

Digidesign WaveDriver

The Digidesign WaveDriver is a single-client, multichannel sound driver that allows third-party audio programs that support the WaveDriver MME (Multimedia Extensions) standard to play back through Digidesign hardware.

Digidesign ASIO Driver is automatically installed when you install Pro Tools.

For detailed information on configuring the Digidesign ASIO Driver, see Appendix B, “Digidesign ASIO Driver (Windows Only).”

To use Digidesign ASIO Driver without Pro Tools, use the stand-alone version of the Digidesign ASIO Driver. The stand-alone version of Digidesign ASIO Driver is available on the Digidesign Web site (www.digidesign.com)

Digidesign WaveDriver is automatically installed when you install Pro Tools.

For detailed information on configuring the Digidesign WaveDriver, see Appendix C, “Digidesign WaveDriver (Windows Only).”

To use Digidesign WaveDriver without Pro Tools, use the stand-alone version of the Digidesign WaveDriver. The stand-alone version of Digidesign WaveDriver is available on the Digidesign Web site (www.digidesign.com)
Pro Tools Demo Session

The Pro Tools LE Installer CD includes a demo session that you can use to verify that your system is working.

⚠️ Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 18.

To install the demo session:

1. Insert the Pro Tools LE Installer CD in your CD-ROM drive. Locate and double-click Setup.exe, in D (CD-ROM drive):\Additional Files\Pro Tools LE Demo Session Installer.
2. Set the install location to your audio drive and click Install.
3. When installation is complete, click OK.

MacOpener

MacOpener 6.0.5 and higher lets you mount HFS/HFS+ drives on a Windows-based Pro Tools system, as a Transfer drive.

⚠️ Transfer drives can be used for storage, but not for playback or recording.

💡 The MacDrive utility can be used instead of MacOpener. For more information about MacDrive, visit the Mediafour Web site (www.mediafour.com).

To share Pro Tools sessions between Macintosh and Windows systems, select the “Enforce Mac/PC Compatibility” option when creating the session, or when saving a session copy to a Windows audio drive formatted using NTFS or FAT32.

⚠️ Avoid using MacOpener on HFS-formatted drives. It is recommended that you use MacOpener on NTFS or FAT32 drives instead. To move material from HFS-formatted drives to NTFS or FAT32 drives, use the Save Session Copy In command in Pro Tools.

💡 While SDII files can be exported or converted on import, they cannot be used within Pro Tools sessions on Windows.

To install and configure the MacOpener demo included with Pro Tools:

1. Insert the Pro Tools Installer CD into your CD-ROM drive.
2. Locate and double-click the MacOpener installer file in the MacOpener Demo folder located at D (CD-ROM drive):\Additional Files\MacOpener Demo Installer. Follow the on-screen instructions to install the MacOpener. After installation is complete, restart your computer.
3. Choose Start > Programs > MacOpener > MacOpener Driver Preferences.
4. Verify that the MacOpener Driver is enabled. Under Driver Settings, select “Enable MacOpener Driver.”
5. Under Extension Mapping, select “Do not add the PC extension to the Mac file name.”
6. Click OK to quit the MacOpener Driver Preferences.
7 Choose Start > Programs > MacOpener > Mac Lic.exe. When installation is complete, close the installer.

⚠️ All formatting and maintenance of HFS/HFS+ drives should be carried out when the drive is connected to a Macintosh.

💡 For more information about MacOpener and its performance limitations, see the Pro Tools Reference Guide.

---

**Launching Pro Tools LE**

When launching Pro Tools LE the first time, you are prompted to enter an authorization code to validate your software.

⚠️ With new Digi 002 and Digi 002 Rack systems, the authorization code is located on the inside cover of the Getting Started with Digi 002 & Digi 002 Rack Guide. With software upgrades, the authorization code is located on the inside cover of the Upgrading Guide.

To authorize Pro Tools LE software:

1. Double-click the Pro Tools LE shortcut on your desktop (or the application in the Pro Tools folder inside the Digidesign folder).

⚠️ If you get a warning dialog about updating the Digi 002 or Digi 002 Rack firmware, follow the on-screen instructions to perform the firmware update. See “Updating Digi 002 or Digi 002 Rack Firmware” on page 14.

2. Enter the authorization code in the dialog (making sure to type it exactly as printed, and observing any spaces and capitalization), then click Validate.

**Updating Digi 002 or Digi 002 Rack Firmware**

When you launch Pro Tools software, it automatically checks the version of the unit’s firmware, and prompts you to update it if a newer version is available.

If you update your unit’s firmware, let the update complete before disconnecting or turning off your system.

When the download and reprogramming process is complete, you may get a message that Pro Tools cannot communicate with Digi 002 or Digi 002 Rack. In this case, wait up to 30 seconds. If the message does not go away, disconnect then reconnect Digi 002 or Digi 002 Rack and click OK.
Configuring Pro Tools LE

Pro Tools System Settings

Pro Tools LE lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the hardware cache used to handle host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins.

- Lower Hardware Buffer Size settings reduce monitoring latency, and are useful when you are recording live input.
- Higher Hardware Buffer Size settings allow for more audio processing and effects, and are useful when you are mixing and using more RTAS plug-ins.

⚠️ In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can affect the accuracy of plug-in automation, mute data, and timing for MIDI tracks.

To change the Hardware Buffer Size:


2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.

3. Click OK.

CPU Usage Limit

The CPU Usage Limit controls the percentage of CPU resources allocated to Pro Tools host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins.

- Lower CPU usage settings reduce how much Pro Tools processing affects other CPU-intensive tasks (such as screen redraws), and limit the amount of processor resources available for Pro Tools tasks. They are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.
- Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more real-time plug-ins.

⚠️ Increasing the CPU Usage Limit may slow down screen response on slower computers.
The maximum CPU Usage Limit is 85 percent for single-processor computers, and 99 percent for multi-processor computers. (The 99 percent setting dedicates one entire processor to Pro Tools.)

**To change the CPU Usage Limit:**
2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

**DAE Playback Buffer Size**

The DAE Playback Buffer Size determines the amount of memory DAE uses to manage disk buffers, which affects system performance.

- Lower DAE Playback Buffer Size settings can improve playback and recording initiation speed. However, a lower setting can make it difficult for slower hard drives to play or record tracks reliably.

- Higher DAE Playback Buffer Size settings can allow for a higher density of edits in a session. However, a higher setting can cause a time lag to occur before playback or recording begins. It can also cause a time lag to occur when you are editing during playback.

**To change the DAE Playback Buffer Size:**
2. From the DAE Playback Buffer pop-up menu, select a buffer size.
3. Click OK.

---

**Pro Tools Hardware Settings**

Using the Hardware Setup dialog, you can select the default sample rate and clock source for your system, and configure the digital inputs for your system.

**Default Sample Rate**

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

💡 You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. (Refer to the Pro Tools Reference Guide for details.)

**To change the default Sample Rate:**
1. Make sure that no Pro Tools session is open.
2. Choose Setups > Hardware Setup.

3. Select the sample rate from the Sample Rate pop-up menu.
4. Click OK.
Clock Source

Using the Hardware Setup dialog, you can select the clock source for the system. If you are recording directly into Pro Tools, you will usually use the Internal setting. If you are transferring material from an external digital device, select the corresponding clock source. (See “Recording a Digital Source” on page 17.)

To select the clock source:
1. Choose Setups > Hardware Setup.
2. Choose the clock source from the Clock Source pop-up menu.
3. Click OK.

⚠️ Your digital input device must be connected and turned on for Pro Tools to synchronize to it. If your input device is not turned on, leave the Clock Source set to Internal.

Recording a Digital Source

If you are recording from an optical or S/PDIF device, you will need to select a Clock Source. In most cases, you will synchronize the Pro Tools clock to the external device.

To configure Pro Tools LE for a digital source:
1. Connect an ADAT or Optical S/PDIF format device to the Optical In connector, or an RCA S/PDIF format device to the RCA S/PDIF In connector on the back of the Digi 002.
2. Choose Setups > Hardware Setup.
3. Make sure the correct digital input option is selected for your setup. When you select RCA S/PDIF, the Optical ports are available for standard ADAT Optical (or “Lightpipe”) input. When you select Optical S/PDIF, the RCA digital input connector is inactive.

⚠️ You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time.

4. From the Clock Source pop-up menu, select Internal if you are synchronizing the external device to Digi 002 or Digi 002 Rack. If you are synchronizing the Pro Tools clock to the external device, select ADAT, RCA (S/PDIF) or Optical (S/PDIF), depending on where you connected your digital device.

⚠️ Your digital input device must be connected and powered on. If your input device is not powered on, leave the Clock Source set to Internal.

Configuring I/O Setup

Using the I/O Setup dialog, you can label Pro Tools LE input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the Digi 002 and Digi 002 Rack.

Pro Tools LE has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename the default I/O paths.
Getting Started with Digi 002 & Digi 002 Rack

To rename I/O paths in I/O Setup:

1. Choose Setups > I/O Setup.

2. Click the Input, Output, Insert, or Bus tab to display the corresponding paths.

3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Return.

4. Click OK.

Refer to the Pro Tools Reference Guide (or choose Help > Pro Tools Reference Guide) for more information on renaming I/O paths.

After configuring Pro Tools LE and your system, you should save an image of your system using Norton Ghost. Norton Ghost lets you save and recall known good configurations of your system and settings, which can help you recover if you encounter any problems in the future.

For more information on Ghost, visit the Symantec Web site (www.symantec.com)

Hard Drive Configuration and Maintenance

Formatting an Audio Drive

On Windows, it is recommended that you start with newly formatted drives dedicated for audio. For optimum performance, audio drives should be formatted with the FAT32 or NTFS file system.

To format and configure an audio drive:

1. Right-click My Computer and choose Manage.

2. Under Storage, choose Disk Management.

3. In the Disk Management window, right-click the hard drive you will use for audio and choose Format.

4. For optimal disk performance, select 32K from the Allocation unit size pull-down. This increases how efficiently audio data is written to and read from the drive.

5. Make sure the Quick Format option is deselected, then click Start, and follow the on-screen instructions.

Pro Tools only supports Basic drive Types.

6. When formatting is complete, close the Format window.

Audio Drives and Disk Cleanup

The process of recording, editing, and deleting tracks and sessions can quickly decrease overall drive performance. It is suggested that you regularly use Disk Cleanup (or an equivalent utility) to assess the condition of drives and, if necessary, delete temporary files and other unused data.
To use Disk Cleanup:

1. Choose Start > Control Panel.
2. Launch Administrative Tools.
4. Double-click Storage.
5. Double-click Disk Management.
6. Select the desired volume in the list, then choose File > Options.

Disk Cleanup determines how performance is being affected by drive condition, and lets you review and delete temporary and other unnecessary files from the selected volume. For more information on using Disk Cleanup, see your Windows XP documentation.

Defragmenting an Audio Drive

Periodically defragment audio drives to maintain system performance.

To defragment an audio drive:

1. Right-click My Computer and choose Manage.
2. Under Storage, choose Disk Defragmenter.
3. In the Disk Defragmenter window, choose the drive you want to defragment
4. Click the Defragment button and follow the on-screen instructions.
5. When defragmenting is complete, close the Computer Management Window.

Avoid Recording to System Drives

Although Pro Tools will let you record to your system drive, this is generally not recommended. Recording and playback on system hard drives results in lower track counts and fewer plug-ins. You should record to system drives only when necessary (for example, if your computer system has just one hard drive).

Removing Pro Tools on Windows XP

If you need to remove Pro Tools LE from your computer use the Add or Remove Programs command.

To remove Pro Tools from your computer:

1. Choose Start > Control Panel.
2. Launch Add or Remove Programs.
3. From the Currently installed programs list, select Digidesign Pro Tools LE.
4. Click the Change/Remove button.
5. Follow the onscreen instructions to remove Pro Tools.
Macintosh Configuration

This chapter contains information for Macintosh systems only. If you are installing Pro Tools on a Windows computer, see Chapter 2, “Windows Configuration.”

⚠️ Before installing this version of Pro Tools, please refer to the Read Me information included on the Pro Tools Installer CD-ROM.

Installation Overview

Installation of the Digi 002 or Digi 002 Rack on a Macintosh includes the following steps:

2. Configuring “Apple System Settings for Mac OS X” on page 22.
4. “Connecting Digi 002 or Digi 002 Rack to the Computer” on page 24.

⚠️ When connecting Digi 002 to your computer the first time, your computer should be off. If your computer is on, power it down.

6. Making audio and MIDI connections to the Digi 002. (See Chapter 7, “Connecting Your Studio.”)

Testing Digi 002

(Digi 002 Only)

Before you install Pro Tools LE software or connect Digi 002 to your computer for the first time, you should power up the unit to be sure it is working correctly.

⚠️ When connecting Digi 002 to your computer the first time, your computer should be off. If your computer is on, power it down.

To set up and test the Digi 002:

1. Plug the Digi 002 into a standard AC receptacle, using the AC power cable included with the unit.

Digi 002 is auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

2. Power on the Digi 002 unit by turning on the power switch on the back panel. After a short power-up sequence, the Channel Scribble Strips on the unit show “Digi 002 Standby,” and the Standalone switch flashes to indicate Standby mode.

3. Press the Standalone switch in the upper right of the top panel of Digi 002. The Channel Scribble Strips on the unit show “Enter Standalone Mode?”
4 Press the Channel Select switch under “Yes” to enter Stand-alone mode. The Channel Scribble Strips on the unit will show the default names of the channel inputs, “In1” through “In8.”

5 To return Digi 002 to Standby mode, press the Standalone switch a second time. The Channel Scribble Strips on the unit will show “Exit Standalone Mode?”

6 Press the Channel Select switch under “Yes” to return to Standby mode.

---

**Apple System Settings for Mac OS X**

To ensure optimum performance with Pro Tools LE, configure the following settings before you install Pro Tools software.

⚠️ Do not use the Mac OS X automatic Software Update feature, as it may install components that have not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, refer to the latest compatibility information on the Digidesign Web site (www.digidesign.com).

**To configure Mac OS X for Pro Tools LE:**

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools LE. For details on Administrator privileges in Mac OS X, refer to your Apple Mac OS X documentation.

2. Choose System Preferences from the Apple Menu and click Energy Saver.

3. Click the Sleep tab and turn off the Energy Saver feature by setting the sleep feature to Never.

4. Return to the System Preferences and click Software Update.

5. Deselect “Automatically check for updates when you have a network connection.”

6. Close the Software Update dialog box.


---

**Installing Pro Tools LE**

After the Apple System software settings are configured, you are ready to install Pro Tools LE.

**To install Pro Tools LE on Mac OS X:**

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, refer to your Apple Mac OS X documentation.


3. Enter your Administrator password and click OK to authenticate the installation.

4. Follow the on-screen instructions to continue and accept installation.

5. In the Installer window, make sure the Install Location is on your Start-up hard drive.

6. In the Installer window, choose Custom Install from the pop-up menu, and click Install.

7. Follow the remaining on-screen instructions to install Pro Tools.

8. When installation is complete, click Restart.
Audio MIDI Setup (AMS)
(Optional)
If you plan to use any MIDI devices with Pro Tools, configure your MIDI setup with the Apple Audio MIDI Setup (AMS) utility. See Appendix F, “Configuring AMS (Mac OS X Only)” for details.

Optional Software on the Pro Tools Installer CD-ROM

Your Pro Tools Installer CD-ROM includes several software options.

Digidesign CoreAudio Driver
The Digidesign CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio compatible applications to record and play back through Digidesign hardware.

The Core Auto Driver is installed by default when you install Pro Tools.

For detailed information on configuring the Digidesign CoreAudio Driver, see Appendix D, “Digidesign CoreAudio Driver (Macintosh Only).”

Stand-Alone CoreAudio Driver Installer
This version of Digidesign CoreAudio Driver can be installed on Digidesign-qualified Pro Tools systems running on Macintosh (for example, if the CoreAudio Driver was uninstalled), or it can be installed as a stand-alone driver on Macintosh systems that do not have Pro Tools installed.

For detailed information on installing and configuring CoreAudio Driver on systems with or without Pro Tools, see the electronic pdf of the CoreAudio Usage Guide.

Pro Tools Demo Session
The Pro Tools LE Installer CD-ROM includes a demo session that you can use to verify that your system is working.

To install the demo session:
1. Insert the Pro Tools LE Installer CD in your CD-ROM drive. Locate and double-click the demo session installer icon.
2. Select your audio drive as the install location and click Install.
3. When installation is complete, click Quit.
Connecting Digi 002 or Digi 002 Rack to the Computer

After installing Pro Tools LE software and restarting your computer, connect the Digi 002 or Digi 002 Rack to the computer before launching Pro Tools LE.

⚠️ When connecting Digi 002 or Digi 002 Rack to your computer the first time, your computer should be off. If your computer is on, power it down.

To connect the Digi 002 or Digi 002 Rack to your computer:

1. Plug the Digi 002 or Digi 002 Rack into a standard AC receptacle, using the AC power cable included with the unit.

Digi 002 and Digi 002 Rack are auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

2. Power on the unit by toggling the power switch on the back panel (Digi 002), or pressing the power switch on the front panel (Digi 002 Rack). After a short power-up sequence the Sample Rate LED and Monitor Mute switch illuminate to indicate the unit is on.

3. Locate the FireWire cable that came with your unit.

4. Plug one end of the FireWire cable into one of the ports marked “1394” on the back panel of the Digi 002 or Digi 002 Rack. Either port will work.

Connecting FireWire Drives

Connect FireWire hard drives directly to a FireWire port on your computer. Do not connect a FireWire hard drive to the second FireWire port on the back panel of Digi 002 or Digi 002 Rack because the FireWire ports do not pass audio data when the unit is powered off.

To connect a FireWire hard drive:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on the computer, and connect Digi 002 or Digi 002 Rack to another FireWire port on the computer.
  – or –
If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect Digi 002 or Digi 002 Rack to an available FireWire port on the drive.

While it is possible to connect a FireWire hard drive to an available port on Digi 002 or Digi 002 Rack if either unit is powered off, any mounted FireWire drives will lose their data connection with the computer. This may result in hard drive errors or data loss.

4-pin FireWire Cable

Digi 002 and Digi 002 Rack include a 6-pin to 6-pin FireWire cable. Some Windows laptops include a 4-pin FireWire port. To use Digi 002 or Digi 002 Rack with these computers, a 4-pin to 6-pin cable is required. Purchase this cable (model #CS625) through your authorized Digidesign dealer or online through the DigiStore (www.digidesign.com).

This cable can also be purchased at computer supply stores. Maximum supported cable length for FireWire (IEEE-1394) is 14 feet (4.3 meters).

Connecting Other FireWire Devices to Digi 002 or Digi 002 Rack

The second FireWire port on the Digi 002 unit is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, Digi 002 supplies power from the computer through its FireWire ports, letting you recharge batteries in other FireWire devices.

Launching Pro Tools LE

When launching Pro Tools LE the first time, you are prompted to enter an authorization code to validate your software.

With new Digi 002 and Digi 002 Rack systems, the authorization code is located on the inside cover of the Getting Started with Digi 002 & Digi 002 Rack Guide. With software upgrades, the authorization code is located on the inside cover of the Upgrading Guide.

To authorize Pro Tools LE software:

1. Double-click the Pro Tools LE application (located in the Pro Tools folder, inside the Digidesign folder).

If you get a warning dialog about updating the Digi 002 or Digi 002 Rack firmware, follow the on-screen instructions to perform the firmware update. See “Updating Digi 002 or Digi 002 Rack Firmware” on page 25.

2. Enter the authorization code in the dialog when prompted (making sure to type it exactly as printed, and observing any spaces and capitalization) then click Validate.

Updating Digi 002 or Digi 002 Rack Firmware

When you launch Pro Tools software, it automatically checks the version of the unit’s firmware, and prompts you to update it if a newer version is available.

If you update your unit’s firmware, let the update complete before disconnecting or turning off your system.
When the download and reprogramming process is complete, you may get a message that Pro Tools cannot communicate with Digi 002 or Digi 002 Rack. In this case, wait up to 30 seconds. If the message does not go away, disconnect then reconnect Digi 002 or Digi 002 Rack and click OK.

---

**Configuring Pro Tools LE**

**Pro Tools System Settings**

Pro Tools LE lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

**Hardware Buffer Size**

The Hardware Buffer Size (H/W Buffer Size) controls the size of the hardware cache used to handle host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins.

- Lower Hardware Buffer Size settings reduce monitoring latency, and are useful when you are recording live input.
- Higher Hardware Buffer Size settings allow for more audio processing and effects, and are useful when you are mixing and using more RTAS plug-ins.

⚠️ In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can affect the accuracy of plug-in automation, mute data, and timing for MIDI tracks.

To change the Hardware Buffer Size:

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.

**CPU Usage Limit**

The CPU Usage Limit controls the percentage of CPU resources allocated to Pro Tools host processing tasks.

- Lower CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.
- Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more real-time plug-ins.

⚠️ Increasing the CPU Usage Limit may slow down screen responses on slower computers.

The maximum CPU Usage Limit is 85 percent for single-processor computers, and 99 percent for multi-processor computers. (The 99 percent setting dedicates one entire processor to Pro Tools.)
To change the CPU Usage Limit:
2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

**DAE Playback Buffer Size**

The DAE Playback Buffer Size determines the amount of memory DAE uses to manage disk buffers, which affects system performance.

- Lower DAE Playback Buffer Size settings can improve playback and recording initiation speed. However, a lower setting can make it difficult for slower hard drives to play or record tracks reliably.
- Higher DAE Playback Buffer Size settings can allow for a higher density of edits in a session. However, a higher setting can cause a time lag to occur before playback or recording begins. It can also cause a time lag to occur when you are editing during playback.

To change the DAE Playback Buffer Size:
2. From the DAE Playback Buffer pop-up menu, select a buffer size.
3. Click OK.

**Pro Tools Hardware Settings**

Using the Hardware Setup dialog, you can select the default sample rate and clock source for your system, and configure the digital inputs on the Digi 002 or Digi 002 Rack.

**Default Sample Rate**

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. (See “Starting a Session” on page 69.)

To change the default Sample Rate:
1. Make sure that no Pro Tools session is open.
2. Choose Setups > Hardware Setup.
3. Select the sample rate from the Sample Rate pop-up menu.
4. Click OK.

Hardware Setup dialog (Digi 002 shown)
Clock Source

Using the Hardware Setup dialog, you can select the clock source for the system. If you are recording directly into Pro Tools, you will usually use the Internal setting. If you are transferring material from an external digital device, select the corresponding clock source. (See “Recording a Digital Source” on page 28.)

To select the Clock Source:

1. Choose Setups > Hardware Setup.
2. Choose the clock source from the Clock Source pop-up menu.
3. Click OK.

⚠️ Your digital input device must be connected and turned on for Pro Tools to synchronize to it. If your input device is not turned on, leave the Clock Source set to Internal.

Recording a Digital Source

If you are recording from an Optical or S/PDIF device, you will need to select a Clock Source. In most cases, you will synchronize the Pro Tools clock to the external device.

To configure Pro Tools LE for a digital source:

1. Connect an ADAT or Optical S/PDIF format device to the Optical In connector, or an RCA S/PDIF format device to the RCA S/PDIF In connector on the back of the Digi 002 or Digi 002 Rack.
2. Choose Setups > Hardware Setup.
3. Make sure the correct digital input option is selected for your setup. When you select RCA S/PDIF, the Optical ports are available for standard ADAT Optical (or “Lightpipe”) input. When you select Optical S/PDIF, the RCA digital input connector is inactive.

⚠️ You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time.

4. From the Clock Source pop-up menu, select Internal if you are synchronizing the external device to Digi 002 or Digi 002 Rack. If you are synchronizing the Pro Tools clock to the external device, select ADAT, RCA (S/PDIF) or Optical (S/PDIF), depending on where you connected your digital device.

⚠️ Your digital input device must be connected and powered on. If your input device is not powered on, leave the Clock Source set to Internal.

Ignore Buffer Underrun Errors (~6086)

Buffer Underrun Error messages can occur during a session if more buffer time is required for processing audio and applying real-time effects than what is currently available. These messages interrupt both playback and recording, prompting you to increase the H/W Buffer Size. In most cases, this is not a problem. But with lengthy recording passes, for example, you may prefer to ignore these messages, and not interrupt the recording session.
The Pro Tools Ignore Buffer Underrun Errors (–6086) feature in the H/W Setup dialog provides options for ignoring these messages during playback and recording. When enabled, Pro Tools sends an audible pop to the Digi 002 or Digi 002 Rack hardware outputs, instead of displaying a buffer underrun error message. These pops are not written to disk.

**To ignore Buffer Underrun Errors (–6086):**

1. Choose Setups > Hardware Setup.
2. From the Ignore Buffer Underrun Errors (–6086) section, do the following:
   - To ignore –6086 error messages during playback, select During Playback.
   - To ignore –6086 error messages during recording, select During Record.
3. Click OK.

**Configuring I/O Setup**

Using the I/O Setup dialog, you can label Pro Tools LE input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the Digi 002 or Digi 002 Rack.

Pro Tools LE has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename the default I/O paths.

**To rename I/O paths in I/O Setup:**

1. Choose Setups > I/O Setup.
2. Click the Input, Output, Insert, or Bus tab to display the corresponding paths.
3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Return.
4. Click OK.

Refer to the Pro Tools Reference Guide (or choose Help > Pro Tools Reference Guide) for more information on renaming I/O paths.
Hard Drive Configuration and Maintenance

It is recommended that you start with a newly initialized audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with the utility named *Disk Utility* included with your Apple System software.

Avoid Recording to System Drives

Although Pro Tools will let you record to your system drive, this is generally not recommended. Recording and playback on system drives results in lower track counts and fewer plug-ins. You should record to system drives only when necessary—for example, if your computer system has just one hard drive.

Removing Pro Tools on Mac OS X

If you need to remove Pro Tools from your computer, you can use the Installer CD-ROM or the downloaded Installer file.

To remove Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed. For details on Administrator privileges in Mac OS X, refer to your Apple OS X documentation.


3. Enter your Administrator password and click OK to authenticate the installation.

4. In the Installer window, choose Uninstall from the pop-up menu, and click Uninstall.

5. Follow the on-screen instructions to remove Pro Tools.

6. When finished, click Quit to close the Installer window.
Digi 002 Operating Modes

Digi 002 can be in any of three states when it is powered on: Standby mode, Pro Tools mode, or Stand-alone mode.

Standby Mode

Digi 002 is in this mode when you first power on the unit, waiting for you to either launch Pro Tools or put the unit in Stand-alone mode.

In Standby mode, the unit displays “Digi 002” and “Standby” in the Scribble Strips, and the Standalone LED flashes.

Pro Tools Mode

Digi 002 is in this mode when the Digi 002 unit is connected to a computer and Pro Tools LE software is running.

If no Pro Tools session is open, the unit displays “Open or create a new session.” When a Pro Tools session is open, the unit mirrors the on-screen controls. In this mode, the Stand-alone LED is off.

To put Digi 002 in Pro Tools mode:

1. Make sure the Digi 002 unit is properly connected to the computer and in Standby mode.
2. Launch Pro Tools LE and open or create a Pro Tools session.

Stand-Alone Mode

When you put Digi 002 in Stand-alone mode, the unit becomes an 8-channel digital mixer that operates independently from Pro Tools.

See Chapter 9, “Using Digi 002 as a Stand-Alone Mixer” for more information on stand-alone operation of Digi 002.
The Digi 002 Top Panel

The Digi 002 top panel is arranged in sections of controls with related functions. The Fader section includes standard channel strip controls, similar to any small-format mixer. The Console/Channel View section provides powerful multi-state controls for viewing and controlling inserts, plug-ins and sends in Pro Tools. The Transport and Navigation controls provide access to many of the on-screen navigation features of Pro Tools.

This chapter covers each of the Digi 002 sections in relation to its function while in Pro Tools mode.

![Diagram of Digi 002 top panel]

Figure 1. Major sections of the Digi 002 top panel
Views in Pro Tools Mode

When Digi 002 is used with Pro Tools, many of its controls perform more than one function, depending on which view you are in. When in Pro Tools mode, the Digi 002 control surface operates in one of three main views: Home View, Console View or Channel View.

Home View

Home View is the default view in Pro Tools that you see when you first open a session, and is actually the same as Console View with the Pan controls displayed.

To put Digi 002 in Home View:

- Press the Pan switch in the upper left-hand corner of the Console View area.

Console View

Console View lets you toggle the Digi 002 to show pan position, send assignments or insert assignments for all channels on the control surface. You can think of Console View as a global view of a given control (pan, send, or insert) on each channel. (See “Console View” on page 37.)

- In Console view, the touch-sensitive faders on Digi 002 mirror the volume faders in Pro Tools.
- In Console view, the LED rings above the rotary encoders indicate either the pan position, the send level, or the insert level for each channel, depending on which Console View switch is lit.

Digi 002 is in Console View when any of the Console View selectors (Pan, Send, or Insert) are lit in the Console View area.

To put Digi 002 in Console View:

- Press the Pan, Send, or Insert switch in the upper left-hand corner of the Console View area.

Channel View

Channel View lets you display all of a selected channel’s plug-in assignments, insert names, or send assignments at the same time. You can think of Channel View as a way to temporarily focus on all the inserts or sends on a single channel.

- In Channel View, the touch-sensitive faders on Digi 002 mirror the volume faders in Pro Tools.
- In Channel View, the LED rings above the rotary encoders indicate values for the selected control, such as plug-in parameters, insert levels, or pan values and send levels, depending on which Channel View switch is lit.

Digi 002 is in Channel View when any of the Channel View selectors (EQ, Dynamics, Insert or Pan/Send) are lit in the Channel View area.

To put Digi 002 in Channel View:

- Press the EQ, Dynamics, Insert, or Pan/Send switch in the Channel View area above the Channel Scribble Strips.

When you first open a Pro Tools session, Digi 002 is in Console View with the Pan switch lit. This default view is also known as “Home View.”
Fader Section

The Digi 002 fader section consists of 8 identical channel strips, each with a touch-sensitive fader, solo and mute switches, a multi-state select switch, and a rotary encoder.

Channel Strip Controls

Channel Faders

Each channel has its own touch-sensitive, motorized fader for controlling levels of audio and MIDI tracks, Auxiliary Inputs, and Master Faders. In Flip mode, other controls, such as send levels or plug-in parameters, can be controlled by the faders.

Channel Solo/Mute Switches

Each channel has Solo and Mute switches, located above the fader. These switches show the Pro Tools solo and mute status for each track. When a track is soloed, the Mute switches on other tracks in the session flash. When a track is muted, the Mute switch is lit continuously.

The Solo switch function follows the Pro Tools Operation preference for latched operation. (See the Pro Tools Reference Guide for details.)

Channel Select Switch

Each channel has a Channel Select switch that performs several functions, depending on the view:

Home View The Channel Select switches allow you to select the corresponding track (indicated on-screen by a highlighted track name) for grouping and other channel-related commands in Pro Tools.

Console View The Channel Select switches are used to select inserts on a particular channel for editing, or to select pre- or post-fader operation for sends.

Channel View The Channel Select switches are used to select and edit individual send or insert settings as displayed across the Channel Scribble Strips.
**Channel Record Ready Indicator**

Each channel has a Record Ready LED. When a track is record-enabled and the transport is stopped, this LED flashes. When Pro Tools is recording, it is lit continuously. (See “Record Enable Switch” on page 35 for details on record-enabling tracks.)

**Rotary Encoders**

These knobs control a variety of parameters, depending on the view:

- **Home View** The rotary encoders control pan position for each track, with the LED rings indicating the pan position with a single LED.
- **Console View** The rotary encoders control send levels for each track, with the LED rings indicating the send levels with an expanding series of LEDs.
- **Channel View** The rotary encoders control plug-in, pan/send, or insert settings, depending on the Channel View selection, with the LED rings showing corresponding states.

**Encoder/Meter LED Ring**

Each rotary encoder has a circle of 15 LEDs above it for indicating data values controlled by the encoder. The style of display depends on the type of data. For example, discrete or stepped information such as pan position or frequency value is shown by a single LED, while an expanding series of LEDs shows values such as send levels, gain, or filter bandwidth.

The LED rings can also be set to show track levels by pressing the Encoder/Meter Mode switch to the right of the encoder area. When set to Meter mode, the LED rings show increasing levels in a clockwise manner, with the last red LED indicating clipping.

**Channel Scribble Strip**

Each channel has a 4-character scribble strip that displays a variety of information, including track, send and insert names, pan position, send levels, or plug-in control information. The default display is the name of the displayed element. When you move a fader or rotary encoder, the scribble strip will temporarily display the value for that control, then return to the default display.

**Global Fader Controls**

Immediately to the right of the channel faders, there are global controls that affect the assignment and operation of all the faders.

**Record Enable Switch**

Pressing the Record Enable switch followed by a Channel Select switch arms the corresponding track for recording.

**To enable tracks for recording:**

1. Press the Record Enable switch. When the Record Enable function is active, the Record Enable switch flashes.
2. Press the Channel Select switch for the tracks you want to enable for recording. When a track is armed for recording, its Record Ready indicator flashes. During recording, its Record Ready indicator is lit continuously.
3. To deactivate the Record Enable function, press the Channel Select switch for the track, then press the Record Enable switch a second time.

**To disable tracks for recording:**

1. Press the Channel Select switch on any track whose Record Ready indicator is flashing to disarm the track for recording.
2 Press the Record Enable switch a second time to deactivate the Record Enable function.

**Fader Flip Switch**

The Fader Flip switch invokes Flip mode, which transfers control assignments from the rotary encoders to the corresponding channel faders, allowing you to use the touch-sensitive faders to edit and automate control values. There are several types of Flip mode, depending on the view.

**To transfer controls from the rotary encoders to the touch-sensitive faders:**
- Press the Flip switch. This switch flashes when Flip mode is activated.
- To exit Flip mode, press the Flip switch a second time.

**Send Flip Mode** When you are in Home View or Console View, the Flip switch moves the send level controls to the channel faders, and the send pan controls to the rotary encoders. The Channel Scribble Strips display the selected send (A–E) for each channel.

For stereo tracks with stereo sends, you can toggle the encoder display between left and right send pan by pressing the Encoder Mode switch immediately to the right of the encoders. Both the Display Scribble Strip and the LEDs above the Encoder Mode switch indicate whether the left or right pan position is displayed.

For mono tracks with stereo sends, only the left pan indicator shows a pan position; the right pan indicator is inactive.

**Plug-In Flip Mode** When you are in Channel View and working with a plug-in insert, the Flip switch moves any plug-in control assignments from the rotary encoders to the faders, allowing you to use the touch-sensitive faders to edit and automate plug-in control values. The details of the controls depend on the particular plug-in you are using.

See “Channel View” on page 38 for more details on working with plug-ins in Channel View.

**Pan/Send Flip Mode** When you are in Channel View and working with the pan and send assignments on a channel, the Flip switch moves the send level controls to channel faders 3–7, and the send pan controls to rotary encoders 3–7. (The first Channel Scribble Strip and encoder continue to show track pan position for that track.)

In this mode, the Channel Select switches toggle pre- and post-fader metering for the corresponding send.

For stereo tracks with stereo sends, you can toggle the encoder display between left and right send pan by pressing the Encoder Mode switch immediately to the right of the encoders.

See “Channel View” on page 38 for more details on working with pan controls and sends in Channel View.

**Master Fader Switch**

Pressing the Master Fader switch arranges all Master Fader tracks in the current session on the right-hand side of the control surface. Pressing this switch a second time returns the control surface to the previous view.
Console/Channel View Section

The Console/Channel View section uses many of the channel fader controls to display and edit pan, send, and insert controls, giving you control over many on-screen elements in Pro Tools.

Console View

Console View lets you toggle the Digi 002 to show pan position, send controls or insert names for all channels on the control surface.

Console View Selectors

These switches toggle the center section of Digi 002 to display one of the three following types of controls: pan, sends, or inserts.

Pan View

This is the default view that appears when you first launch a Pro Tools session, where the faders control track volume and the rotary encoders control channel pan positions. The Channel Scribble Strips show the track names, and temporarily show the channel pan positions when the encoder is moved, or volume information when the fader is moved. In this view, pressing a Channel Select switch selects the corresponding track in Pro Tools.

Send View

This view assigns send level controls to the rotary encoders. The Channel Scribble Strips show the names of currently assigned sends across all channel strips for a given send position (Sends A–E in Pro Tools).

In this view, pressing a Channel Select switch toggles the selected send on that track between pre- and post-fader operation. (See the Pro Tools Reference Guide for details.)

Insert View

This view displays the names of currently assigned inserts (hardware inserts or plug-ins) across all channel strips for a given insert position (Inserts A–E in Pro Tools) in the Channel Scribble Strips.

If a hardware insert or plug-in is selected in Pro Tools, its name flashes in the Scribble Strip. In this view, pressing a Channel Select switch directly under a plug-in name puts Digi 002 into Channel View and displays the plug-in controls across all channel strips.
**Insert/Send Position Selectors**

These switches determine which of the five available send or insert positions (marked A–E in Pro Tools) are displayed in Console View.

**Channel View**

Channel View zooms in on a single track and displays all controls of a certain type (sends, inserts, or plug-ins) horizontally, across all of the Channel Scribble Strips on Digi 002. From this view, you can recall and edit parameters for all the sends on a single track, or all the parameters of a single plug-in.

**Channel View Selectors**

These switches determine the type of information displayed for a selected track. The first two switches focus on particular types of plug-ins, while the second two address all types of inserts and sends.

**EQ**

When you press the EQ switch, Digi 002 identifies channels with equalizer plug-ins assigned to them by illuminating their Channel Select switches. If no EQ plug-ins are present, no Channel Select switches will be lit.

When you press an illuminated Channel Select switch, controls for the first EQ plug-in on that track are assigned to the rotary encoders and displayed in the Channel Scribble Strips. Switched controls, such as Master Bypass or Phase Invert functions, are controlled by the Channel Select switches.

To cycle through all the EQ plug-ins on a channel, hold the EQ switch and repeatedly press the track’s Channel Select switch.

**Dynamics**

When you press the Dynamics switch, Digi 002 identifies channels with dynamics plug-ins (such as compressors or limiters) assigned to them by illuminating their Channel Select switches. If no dynamics plug-ins are present, no Channel Select switches will be lit.

When you press an illuminated Channel Select switch, controls for the first Dynamics plug-in on that track are assigned to the rotary encoders and displayed in the Channel Scribble Strips. Switched controls, such as Phase Invert or In/Out for EQ bands, are controlled with the Channel Select switches below the corresponding Scribble Strips.

To cycle through all the Dynamics plug-ins on a channel, hold the Dynamics switch and repeatedly press the track’s Channel Select switch.

**Inserts**

When you press the Inserts switch, Digi 002 identifies channels with any insert assigned to them (including software plug-ins or hardware I/O inserts) by illuminating their Channel Select switches. If no inserts are present, no Channel Select switches will be lit.

When you press an illuminated Channel Select switch, the names of all inserts on that track are displayed in the Channel Scribble Strips. To select a plug-in insert for editing, press the corresponding Channel Select switch. (While the names of hardware I/O inserts are displayed, they have no editable parameters, so the Channel Select switches and the rotary encoders have no effect on them.)

To cycle through all the inserts on a channel, hold the Insert switch and repeatedly press the track’s Channel Select switch.
Pan/Send  When you press the Pan/Send switch, Digi 002 identifies channels with sends assigned to them by illuminating their Channel Select switches. If no sends are present, no Channel Select switches will be lit.

When you press an illuminated Channel Select switch, Channel Scribble Strip 1 and the first rotary encoder show track pan position for that track. (If the track is a stereo track, you can toggle between left and right pan by pressing the Encoder Mode switch immediately to the right of the encoders.)

Channel Scribble Strips 3–7 show the names and their rotary encoders control the levels for all five sends on that track. (Channel Scribble Strip 2 is inactive.) In this mode, the Channel Select switches on channels 3–7 toggle pre- and post-fader metering for the corresponding send.

Plug-In Page Switches Plug-In controls are organized in pages. In a process much like banking of channel faders, when a plug-in has more controls than can fit on the Channel Scribble Strips at one time, you can use these switches to page through the plug-in controls.

When a plug-in has multiple pages of controls, one of the Plug-In Page switches will flash to indicate a next or previous page. The total number of pages is shown in the Status Display when you press the flashing Plug-In Page switch.

Multi-Mono Plug-ins

When working with a multi-mono plug-in, you can toggle the view between the left and right sides of the plug-in by holding down the Display switch when you press the Channel Select switch to select a plug-in from Channel view.

The resulting display shows “left” and “right” in the Scribble Strips, allowing you to choose between the two sides of the multi-mono plug-in by pressing the corresponding Channel Select switch.

Plug-In Master Bypass Switch  This switch bypasses either a single plug-in or all plug-ins on a channel, depending on the current view. If the controls for only one plug-in are displayed, only that plug-in will be bypassed. If all the plug-ins on a channel are displayed, all of those plug-ins will be bypassed.

If no plug-ins are displayed, the Master Bypass function is unavailable.

Hardware I/O inserts cannot be bypassed in Pro Tools, so the Plug-In Master Bypass switch has no effect on them.

Esc (Escape/Cancel) Switch  When flashing, this switch allows you to cancel certain operations on the Digi 002, such as Channel View selections. The Escape/Cancel switch also functions as a “cancel” button for many on-screen dialogs in Pro Tools.
Transport and Navigation Controls

These Digi 002 controls mirror the operation of on-screen transport and navigation controls in Pro Tools. In addition, Function keys allow you to invoke special control surface commands and move quickly between different display modes.

**Transport Controls**

These switches correspond to transport functions in Pro Tools.

- **RTZ** (Return to Zero) Sets the playback cursor to the beginning of the session
- **REW** (Rewind) Rewinds through the session from the current cursor position
- **FFW** (Fast Forward) Fast-forwards through the session from the current cursor position
- **STOP** Stops playback or recording
- **PLAY** Begins playback from the current cursor position
- **REC** (Record) Arms Pro Tools for recording

**Record/Playback Mode Switches**

- **Loop Play** Toggles Loop Playback on and off
- **Loop Rec** Toggles Loop Record mode on and off
- **QuickPunch** Toggles QuickPunch Record mode on and off

**Window Show/Hide Switches**

- **Plug-In** Opens or closes the window for the currently selected plug-in
- **Mix** Opens, brings forward, or closes the Pro Tools Mix window
- **Edit** Opens, brings forward, or closes the Pro Tools Edit window

Digi 002 transport and navigation controls
Navigation and Zoom Section

These multi-purpose keys control the display of Pro Tools tracks on the Digi 002 control surface, on-screen zoom functions, and other Pro Tools navigation functions.

Fader Bank, Nudge and Display Zoom Switches

Bank When the Bank switch is lit, the Left and Right arrow keys move the Digi 002 tracks across the Pro Tools mixer eight faders at a time.

Nudge When the Nudge switch is lit, the Left and Right arrow keys move the Digi 002 tracks across the Pro Tools mixer one track at a time.

Zoom When the Zoom switch is lit, the Left and Right arrow keys zoom the Pro Tools Edit window display horizontally, and the In and Out keys zoom the display vertically.

Navigation and Zoom Keys

Text Entry Fields When you are editing numerical values such as Selection Start, End, and Length, or Pre- and Post-Roll in the Edit or Transport windows, the Left and Right arrow keys let you navigate among editable fields. The In and Out keys increment or decrement the selected value.

Selection In/Out Points In Bank and Nudge modes, the Navigation keys mirror the function of the Up and Down arrow keys on the computer keyboard. You can press these keys to mark In and Out points during playback, in order to make selections in the Pro Tools Edit window. If you have already made a selection in the Edit window, the Up and Down arrow keys move the selection up and down your track list.

Function/Utility Switches

F1 (Utility) Enters Utility mode during Digi 002 stand-alone operation only. This is where you set control surface and input preferences, as well as run pre-programmed diagnostic tests on the Digi 002 unit.

F2 (Naming) Allows you to name channels while using Digi 002 in Stand-alone mode only. (See “Naming Channels” on page 103.)

F3 (Snapshot) Allows you to store and recall up to 24 mixer configurations for quick recall or for use as mixer templates, in Stand-alone mode only. (See “Storing Snapshots” on page 110.)

F4 (Fader Mute) Temporarily disables Digi 002 fader movement while working with Pro Tools, allowing you to monitor audio playback without fader noise. To disable fader movement, press F4 while in Pro Tools mode. To restore fader movement, press F4 a second time.

The Fader Mute feature has no effect on fader automation or audio levels during playback.

F5 (Focus) Displays controls in the Digi 002 Channel Scribble Strips for the currently active plug-in window, as in Channel View. To return to the last Console view, press F5 a second time.
Mic/Line/Instrument Input Controls

Digi 002 is equipped with four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel of Digi 002.

Inputs 1–4 accept microphone, instrument (direct in) or line-level signals. Inputs 5–8 accept line-level signals only.

When Digi 002 is used to control Pro Tools, these inputs show up as “Mic/Line 1–4” in the default Pro Tools I/O Setup.

Inputs 1–4 have the following controls:

**Mic/Line/Instrument Selector** This switch toggles the input between microphone or line (instrument) operating levels.

**High Pass Filter Switch** This switch enables a high pass filter (75 Hz, 12 dB/octave rolloff) on the input, for filtering out rumble or AC hum.

**Input Gain Control** This knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.

⚠️ Engage the Mic Selector only if you have an XLR cable plugged in to the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.

Monitor Section

The Monitor section of Digi 002 provides several options for routing outputs and monitoring alternate input sources.

**Alternate Input Routing Controls**

- **Alt Src to Mon** This switch routes the –10 dBV input pair directly to the Monitor and Headphone Outputs on Digi 002. This function also works when Digi 002 is in Stand-alone mode.

- **Alt Src to 7–8** This switch routes the –10 dBV input pair directly to Inputs 7 and 8 of Pro Tools, and does not send it to the Monitor Outputs. This allows you to route the input signal directly into Pro Tools without the need to repatch any cables.

When Alt Src to 7–8 is enabled, analog inputs 7–8 (1/4-inch TRS connectors on the back panel of Digi 002) are disabled.

Digidesign 002 monitor and headphone controls

**Alternate Input Routing Controls**

- **Alt Src to Mon** This switch routes the –10 dBV input pair directly to the Monitor and Headphone Outputs on Digi 002. This function also works when Digi 002 is in Stand-alone mode.

- **Alt Src to 7–8** This switch routes the –10 dBV input pair directly to Inputs 7 and 8 of Pro Tools, and does not send it to the Monitor Outputs. This allows you to route the input signal directly into Pro Tools without the need to repatch any cables.

When Alt Src to 7–8 is enabled, analog inputs 7–8 (1/4-inch TRS connectors on the back panel of Digi 002) are disabled.
Monitor and Headphone Level Controls

**Monitor Level Control** Digi 002 provides a pair of Monitor Outputs that mirror its Main Outputs (or outputs 1–2), which correspond to outputs 1–2 in Pro Tools. This knob controls the volume of those Monitor Outputs.

**Headphone Level Control** The Headphone Output on Digi 002 also mirrors outputs 1–2 in Pro Tools, and is independent of the Monitor Outputs. This knob controls the volume of the independent Headphone Output.

**Monitor Mute Switch** This switch mutes the Digi 002 Monitor Outputs only, and has no effect on the Main Outputs or the Headphone Output. Monitor Mute is automatically engaged when you power up the Digi 002 unit.

**Mono Output Switch** This switch temporarily combines the output signals 1 and 2 in both the Monitor Outputs and the Headphone Output. This is helpful for checking phase relationships of stereo material. The Mono Output switch has no effect on the Main Outputs.

**Headphone Jack** This jack accepts a standard 1/4-inch stereo headphone connector.

Keyboard Modifier Switches

Many keyboard commands in Pro Tools use modifier keys, which are pressed in combination with other keys or with a mouse action.

Refer to the electronic PDF versions of the Pro Tools Reference Guide and the Keyboard Shortcuts for more information.

The Modifier switches on the left-hand side of Digi 002 mirror the functions of modifier keys on the computer keyboard. You can use these switches on Digi 002 in any combination with keys on your computer while working with Pro Tools.

**Shift/Add Switch** Allows you to extend a track selection or add to a group of selected items

**Option/All Switch** Applies an action or command to all tracks in a Pro Tools session

**Control/Clutch Switch** Temporarily disengages a control from grouped behavior

**Command Switch** Allows fine adjustment of controls and automation breakpoints
Status Indicators and Display Controls

The area above the Transport and Navigation Controls on Digi 002 contains status indicators, an 8-character LED Scribble Strip, and controls for displaying information about Pro Tools sessions.

Display Scribble Strips and Display Mode Switch

The Display Scribble Strips have two modes: Status mode, which shows the current status of the Channel Scribble Strips, and Counter mode, which mirrors the main counter in Pro Tools. To toggle between the two display modes, press the Display Mode switch directly to the left of the Display Scribble Strips.

In addition, pressing the Command switch in tandem with the Display Mode switch allows you to set channels to display numerical parameter values by default, rather than control names. For example, in Pan view, when you press Command+Display, fader volume levels (in dB) are the default display.

Status Mode

In Status mode, the Display Scribble Strips show information about the current view.

Console View When Digi 002 is in Console View, the Display Scribble Strips show which Console mode is active (Pan, Send, or Insert).

When in Pan mode, the Display Scribble shows which pan controls are visible in the rotary encoders, left pan or right pan. (Right pan controls are available for stereo tracks only.)

When in Send mode, the Display Scribble shows the position of the displayed send (A–E).

When in Insert mode, the Display Scribble shows the position of the displayed insert (A–E).
**Channel View**  When Digi 002 is first put into Channel View, the Display Scribble Strips on the right-hand side of the unit identify which Channel View Selector is active (EQ, Dynamics, Inserts, or Pan/Send).

When plug-in controls are displayed in the Channel Scribble Strips, the Display Scribble shows the name of the plug-in.

When pan and send controls are shown in the Channel Scribble Strips, the Display Scribble shows the name of the parent track.

While in Channel View, you can hold the Display Mode switch and press an active track’s Channel Select switch to temporarily display an expanded description of its function.

**Counter Mode**

In Counter mode, the Display Scribble Strips show the current value in the Pro Tools Main Location Indicator. This value can be in Bars:Beats, Minutes:Seconds, or Samples, depending on which of these is chosen as the Main Time Scale in Pro Tools.

The Display Mode switch is lit when Digi 002 is in Counter mode.

**Pan/Meter Indicators and Encoder/Meter Mode Switch**

The Pan/Meter indicators show what type of data is displayed in the Encoder/Meter LED ring: 
- L indicates left pan,
- R indicates right pan (available on stereo channels or sends), and
- Meter indicates that the Encoder LEDs are functioning as level meters.

For stereo tracks or sends, when L and Meter are both lit, the LED rings display levels for the left channel; when R and Meter are both lit, the LED rings display levels for the right channel.

**Enter/OK Switch**

Pressing the Enter/OK switch is equivalent to pressing Return or Enter on the computer keyboard. This allows you to OK on-screen dialogs and create new Memory Locations in Pro Tools directly from the control surface.

**Edit Undo Switch**

Pressing the Edit/Undo switch is equivalent to choosing Edit > Undo in Pro Tools. (See the *Pro Tools Reference Guide* for details on multiple undo capabilities.)

**Standalone Mode Switch**

The Standalone Mode switch turns Digi 002 into a stand-alone 8-channel mixer. (See Chapter 9, “Using Digi 002 as a Stand-Alone Mixer.”)

**Session Sample Rate Indicators**

The Session Sample Rate LEDs indicate the sample rate of the current Pro Tools session.

**Pro Tools Connection Status Indicator**

This status LED, marked “1394,” indicates that communication has been established between Digi 002 and Pro Tools LE software via FireWire.

**MIDI Data Indicators**

The MIDI Data LEDs indicate the presence of MIDI data on the Digi 002 MIDI In or MIDI Out ports.
Chapter 5

The Digi 002 Rack Front Panel

The Digi 002 Rack front panel includes controls for Inputs 1–4, options for routing outputs and monitoring alternate input sources, and indicators for session sample rate, connections status, and MIDI data.

Figure 2. Digi 002 Rack front panel
Mic/Line/Instrument Input Controls

Digi 002 Rack is equipped with four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel of Digi 002 Rack.

Inputs 1–4 accept microphone, instrument (direct in) or line-level signals. Inputs 5–8 accept line-level signals only.

These inputs appear as “Mic/Line 1–4” in the default Pro Tools I/O Setup.

Inputs 1–4 have the following controls:

- **Mic/Line/Instrument Selector** This switch toggles the input between microphone or line (instrument) operating levels.
- **High Pass Filter Switch** This switch enables a high pass filter (75 Hz, 12 dB/octave rolloff) on the input, for filtering out rumble or AC hum.
- **Input Gain Control** This knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.

⚠️ Engage the Mic Selector only if you have an XLR cable plugged in to the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.

Monitor Controls

The Monitor controls of Digi 002 Rack provide several options for routing outputs and monitoring alternate input sources.

- **Alternate Input Routing controls**
- **Mono Output switch**
- **Headphone jack**

Alternate Input Routing Controls

In addition to its 8 standard analog inputs, Digi 002 Rack provides a separate –10 dBV input pair for a device such as a CD player or tape deck.

**Alt Src to 7–8** This switch routes the –10 dBV input pair directly to Inputs 7 and 8 of Pro Tools, and does not send it to the Monitor Outputs. This allows you to route the input signal directly into Pro Tools without the need to repatch any cables.

When Alt Src to 7–8 is enabled, analog inputs 7–8 (1/4-inch TRS connectors on the back panel of Digi 002 Rack) are disabled.

**Alt Src to Mon** This switch routes the –10 dBV input pair directly to the Monitor and Headphone Outputs on Digi 002 Rack.
Monitor and Headphone Level Controls

Monitor Level Control Digi 002 Rack provides a pair of Monitor Outputs that mirror its Main Outputs (or outputs 1–2), which correspond to outputs 1–2 in Pro Tools. This knob controls the volume of those Monitor Outputs.

Headphone Level Control The Headphone Output on Digi 002 Rack also mirrors outputs 1–2 in Pro Tools, and is independent of the Monitor Outputs. This knob controls the volume of the independent Headphone Output.

Monitor Mute Switch This switch mutes the Digi 002 Rack Monitor Outputs only, and has no effect on the Main Outputs or the Headphone Output. Monitor Mute is automatically engaged when you power up the Digi 002 Rack unit.

Mono Output Switch This switch temporarily combines the output signals 1 and 2 in both the Monitor Outputs and the Headphone Output. This is helpful for checking phase relationships of stereo material. The Mono Output switch has no effect on the Main Outputs.

Headphone Jack This jack accepts a standard 1/4-inch stereo headphone connector.

Status Indicators

Session Sample Rate Indicators

The Session Sample Rate LEDs indicate the sample rate of the current Pro Tools session.

Pro Tools Connection Status Indicator

This status LED, marked “1394,” indicates that communication has been established between Digi 002 Rack and Pro Tools LE software through FireWire.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of MIDI data on the Digi 002 Rack MIDI In or MIDI Out ports.
Digi 002 and Digi 002 Rack Back Panels

The Digi 002 and Digi 002 Rack back panels house all the audio, MIDI and computer connectors for the unit. The function of each connector and their associated switches are explained in this section.

See Figure 3 on page 52 and Figure 4 on page 52.

Operating Levels and Headroom

All Digi 002 and Digi 002 Rack audio inputs and outputs are set for 14 dB of headroom below 0 dB, or full code. This means at the nominal reference input level (+4 dBu or –10 dBV) you can have up to 14 dB of headroom before input or output clipping occurs.

The maximum input and output of Digi 002 or Digi 002 Rack using balanced TRS cables on any of the +4 dBu, 1/4-inch connectors is +18 dBu (6.15 Vrms).

Sample Rate and Resolution Support

The Analog-to-Digital and Digital-to-Analog converters on all Digi 002 and Digi 002 Rack analog inputs and outputs, as well as the S/PDIF Digital I/O ports, support sample rates of 44.1, 48, 88.2, and 96 kHz. The Optical I/O ports support sample rates of 44.1 and 48 kHz in ADAT Optical mode, and sample rates up to 96 kHz in Optical S/PDIF mode.

All the analog and digital inputs and outputs on Digi 002 and Digi 002 Rack support up to 24-bit resolution audio.
Figure 3. Digi 002 back panel

Figure 4. Digi 002 Rack back panel
**Analog Inputs**

**Mic Inputs 1–4**
These are balanced, three-conductor XLR connectors for microphone-level analog inputs. Gain is controlled by the corresponding Input Gain control (on the top panel of Digi 002, and on the front panel of Digi 002 Rack).

**Line/Instrument Inputs 1–4**
These are balanced, 1/4-inch TRS jacks for line-level or instrument-level analog audio input connections. Operating levels for these line/instrument inputs are fixed at +4 dBu. Gain is controlled by the corresponding Input Gain knob (on the top panel of Digi 002, and on the front panel of Digi 002 Rack).

Unbalanced connections are also possible with the use of standard 1/4-inch mono plugs.

⚠️ *Digidesign does not recommend the use of unbalanced cables. Unbalanced connections may introduce noise into your audio system. Whenever possible, use balanced cables to make connections to Digi 002 and Digi 002 Rack.*

**Phantom Power**
These switches apply 48V phantom power to Inputs 1–2 and Inputs 3–4 channel pairs respectively, for microphones that require phantom power to operate.

*Dynamic* microphones (like a Shure SM57) do not require phantom power to operate, but are not harmed by it. Most *condenser* microphones (like an AKG C3000) do require phantom power to operate. If you are not sure about the phantom power requirements for your microphone, contact the manufacturer, or read your microphone’s documentation.

⚠️ *Although phantom power can be used safely with most microphones, ribbon microphones can be damaged by it. Always turn off phantom power and wait at least 30 seconds before connecting a ribbon microphone.*

**Analog Inputs 5–8**
These are balanced, 1/4-inch TRS jacks for line-level analog audio input connections.

Operating levels for each of these line-level inputs is switchable between +4 dBu and –10 dBV, using the Operating Level switches immediately to the right of the input jacks.

While Inputs 5–8 do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection. If the devices you are connecting to Digi 002 or Digi 002 Rack have balanced outputs, be sure to use balanced cables for optimal signal-to-noise performance.

**Alt Source Inputs**
These are unbalanced, two-conductor RCA-connectors for connecting alternate audio sources such as CD players or tape decks. The signal from these inputs can be routed directly to the Monitor Outputs (for monitoring) or to Inputs 7–8 (for direct input into Pro Tools) from the top panel of Digi 002 (or the front panel of Digi 002 Rack). Operating levels for these inputs are fixed at –10 dBV.
### Analog Outputs

#### Monitor Outputs

These are balanced, 1/4-inch TRS jacks for line-level analog audio output connections. These outputs correspond to Outputs 1–2 in Pro Tools, allowing you to route mixes to a studio monitoring system. Operating levels for these outputs are fixed at +4 dBu.

Monitor Output level is controlled by the Monitor Level knob on the top panel of Digi 002 (or the front panel of Digi 002 Rack).

#### Main Analog Outputs 1–2

These are balanced, 1/4-inch TRS jacks for line-level analog audio output connections. Operating levels for these outputs are fixed at +4 dBu.

While the Main Analog Outputs do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection. If the devices you are connecting to Digi 002 or Digi 002 Rack have balanced inputs, be sure to use balanced cables for optimal signal-to-noise performance.

#### Alt Main Analog Outputs 1–2

These are unbalanced, two-conductor RCA connectors for direct output to devices such as stereo receivers or tape decks. Operating levels for these inputs are fixed at –10 dBV.

#### Analog Outputs 3–8

These are balanced, 1/4-inch TRS jacks for line-level analog audio output connections. Operating levels for these outputs are fixed at +4 dBu. Unbalanced connections are also supported with the use of standard 1/4-inch mono plugs.

⚠️ *If you plan on connecting Analog Outputs 3–8 to –10 dBV gear, you may want to place a transformer-based line level attenuator between the Digi 002 or Digi 002 Rack output and the input of the destination device to compensate for level differences.*

### Digital I/O

#### S/PDIF Digital I/O

The Sony Phillips Digital Interface Format (S/PDIF) is used in many professional and consumer CD players and DAT recorders. These S/PDIF input and output jacks are unbalanced 2-conductor phono (RCA) jacks that utilize a full 24-bit, 2-channel digital data stream. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

Digi 002 and Digi 002 Rack support consumer mode S/PDIF output format (IEC-958 Type 2) at sample rates of 44.1 kHz and 48 kHz, and professional mode S/PDIF output format (IEC-958 Type 1) at sample rates of 88.2 kHz and 96 kHz. For information on which S/PDIF formats are supported by your S/PDIF-compatible gear, refer to the manufacturer’s documentation.
Optical I/O

These are a pair of TOS-link style connectors for ADAT Optical (8 channels of I/O) or S/PDIF Optical (2 channels of I/O) devices. You can choose between these Optical I/O formats in the Pro Tools Hardware Setup dialog. When transferring material in one of these formats to Pro Tools, be sure to select the appropriate Optical I/O format as the Clock Source in the Hardware Setup dialog.

The Optical I/O ports support sample rates of 44.1 and 48 kHz in ADAT Optical mode, and sample rates up to 96 kHz in Optical S/PDIF mode. The Optical I/O ports support 24-bit, 20-bit and 16-bit resolutions in both modes.

The Optical I/O ports use a standard optical “lightpipe” cable.

About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel optical digital audio connection developed by Alesis. Lightpipe is found on many devices, including Optical (ADAT) decks, modular digital multitracks (MDMs), sound cards, stand-alone A/D or D/A converters, and digital consoles.

MIDI Connectors

Digi 002 and Digi 002 Rack can act as a MIDI interface. With one MIDI input and two MIDI outputs, Digi 002 and Digi 002 Rack provide 16 channels of MIDI input and 32 channels of MIDI output.

⚠️ MIDI ports are only active when Pro Tools is launched.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their IEEE specification, are commonly known as FireWire ports. These provide connections to the computer and other FireWire devices.

FireWire offers a high rate of data transfer and reliability that makes it ideal for audio applications. FireWire devices can be daisy-chained together without the need for terminators.

Connecting Digi 002 or Digi 002 Rack and FireWire Hard Drives

The FireWire ports on Digi 002 and Digi 002 Rack do not pass audio data when they are powered off, so if you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to Digi 002. This will prevent hard drive errors and data loss in case the Digi 002 unit is powered off.

Connecting other FireWire Devices to Digi 002 or Digi 002 Rack

The second FireWire port on Digi 002 or Digi 002 Rack is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when they are powered off, Digi 002 and Digi 002 Rack supply power from the computer through their FireWire ports, letting you recharge batteries in other FireWire devices.
**Footswitch Jack**

This connector allows footswitch control of QuickPunch audio punch-in and punch-out, and MIDI punch-in and punch-out recording features. Both continuous on/continuous off and instantaneous on/off pedals with a 1/4-inch TRS connector are supported. For more information, see “QuickPunch Recording” on page 86.

**Power Switch and AC Power Connector**

The AC power connectors on Digi 002 and Digi 002 Rack accept a standard modular AC power cable.

Digi 002 and Digi 002 Rack are auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

**Link Indicator**

The Link indicator lights when Pro Tools is launched and the connection to the Digi 002 or Dig 002 Rack is recognized.
Chapter 7
Connecting Your Studio

This chapter explains how to connect your Digi 002 or Digi 002 Rack to a monitoring system, digital recorders, and other studio devices, and how to connect audio sources for recording.

Connecting Digi 002 or Digi 002 Rack to a Computer

Your studio setup will differ depending on the type of work you do and the equipment in your studio. The illustrations that follow show two possible setups. Figure 5 shows Digi 002 as the hub of a small recording and mastering studio with Pro Tools. Figure 6 shows Digi 002 Rack as part of a small composing workstation.
Figure 5. Digi 002 project studio configuration running Pro Tools on a desktop computer
Figure 6. Digi 002 Rack micro studio configuration running Pro Tools on a laptop computer
Monitoring Audio

You can use Digi 002 and Digi 002 Rack with a variety of audio monitoring setups, including a power amplifier and speakers, self-powered speakers, and headphones.

The Digi 002 and Digi 002 Rack Monitor Outputs and Headphone Output mirror the output signal on Main Outputs 1–2. The Monitor Output and Headphone Output levels are directly affected by the following front panel controls:

**Monitor Mute** When you power up Digi 002 or Digi 002 Rack, the Monitor Outputs are automatically muted. To unmute the Monitor Outputs, press the Mute switch (located at the top right-hand corner of Digi 002, and on the front panel of Digi 002 Rack).

**Monitor Level and Headphone Level** Levels for the Monitor Output and Headphone Output are adjusted separately with the level controls (located in the upper right-hand side of the Digi 002 top panel, and on the front panel of the Digi 002 Rack).

Connecting Headphones

To connect headphones:

1. Connect headphones to the Headphone jack on the Digi 002 or the Digi 002 Rack. The Headphone input accepts a stereo 1/4-inch plug. If your headphones have a smaller mini-plug, you can purchase an adapter from your local dealer. For best results, use high-quality, closed-ear headphones.

2. Adjust headphone volume with the Headphone Level knob.

**Attention** The Digi 002 and Digi 002 Rack Headphone Outputs can produce very loud output levels. Prolonged exposure can cause hearing damage. Adjust headphone volume carefully.

Connecting Monitor Speakers

To connect monitor speakers with a power amp or self-powered monitor speakers:

1. Connect 1/4-inch cables to the left and right Monitor Outputs on the back of the Digi 002 or the Digi 002 Rack.

2. Connect the other end of the cables to the left and right power amp inputs, or to the left and right self-powered speakers.
Connecting Audio Sources to Digi 002 or Digi 002 Rack

You can connect both analog and digital audio signal sources to Digi 002 or Digi 002 Rack.

⚠ Before making any audio connections to Digi 002 or Digi 002 Rack, turn down Monitor and Headphone levels or mute the Monitor Output to prevent damage to your monitoring system.

Analog Audio Connections

Digi 002 and Digi 002 Rack have eight analog inputs, plus two additional inputs for alternate analog sources, such as a tape deck or CD player.

Microphone-Level Signals

Analog audio signals are output by microphones, synths, mixers, and instruments with magnetic pickups. Of these sources, microphones and magnetic pickup instruments (such as electric guitars) output the quietest signals, and generally require the most amplification.

Digi 002 and Digi 002 Rack include preamps for these sources on Inputs 1–4, with adjustable gain and available 48-volt phantom power. These inputs have both XLR and 1/4-inch connectors; the XLR inputs are specifically for connecting microphones, and the 1/4-inch inputs are for connecting instrument outputs.

Line-Level Signals

Keyboards, preamps, and mixers output line-level audio, which varies with each device between the –10 dBV and +4 dBu standards.

You can connect line-level devices to any of Digi 002 or Digi 002 Rack’s Inputs 1–8, as follows:

Inputs 1–4

Inputs 1–4 have both XLR and 1/4-inch TRS connectors. The XLR connectors are for connecting microphones only. The 1/4-inch TRS connectors are for connecting line-level devices or instruments. Since these inputs have adjustable gain, they are especially useful for devices that output low-level signals.

Inputs 5–8

These inputs accept 1/4-inch balanced or unbalanced connections, and can be switched between –10 dBV and +4 dBu operation.
Making Analog Audio Connections

To connect an analog audio source to Digi 002 or Digi 002 Rack, do the following for your type of input:

**Microphones** Plug a microphone directly into any of the available XLR Microphone Inputs 1–4 on the back panel of the Digi 002 or Digi 002 Rack.

- Press the Mic/Line/Instrument Selector switch (located on the top panel of Digi 002, and on the front panel of Digi 002 Rack) for the corresponding input so that it is in the “Mic” position.
- If your microphone requires phantom power, press the Phantom Power switch (labeled 48V) on the back panel for the corresponding input pair.

> Although phantom power can be used safely with most microphones, ribbon microphones can be damaged by it. You should always turn off phantom power and wait at least 30 seconds before connecting or disconnecting a ribbon microphone.

**Instruments Without Preamps** Plug instruments that output low-level signals (such as electric guitars) directly into any of the available 1/4-inch TRS Inputs 1–4 on the back panel of Digi 002 or Digi 002 Rack. Since these inputs have adjustable gain, they are especially useful for devices that output low-level signals.

- Press the Mic/Line/Instrument Selector switch (located on the top panel of Digi 002, and on the front panel of Digi 002 Rack) for the corresponding input so that it is in the “Line/Inst” position. Inputs 1–4 are designed for input signals with a nominal operating level of +4 dBu. (The Input gain knob should be turned down all the way for +4 dBu devices at unity gain.)

**Line-Level Devices** Plug line-level sources (such as a synthesizer, or a microphone or guitar that has been amplified by an outboard preamp) into any of the 1/4-inch analog inputs on the back of Digi 002 or Digi 002 Rack.

- For Inputs 1–4, press the Mic/Line/Instrument Selector switch (located on the top panel of Digi 002, and on the front panel of Digi 002 Rack) for the corresponding input so that it is in the “Line/Inst” position. Inputs 1–4 are designed for input signals with a nominal operating level of +4 dBu. (The Input gain knob should be turned down all the way for +4 dBu devices at unity gain.)

- For Inputs 5–8, choose either a –10 dBV or +4 dBu operating level for the corresponding input using the switch on the back panel. For information on the appropriate operating level for your input device, refer to the manufacturer’s specifications.
Digital Audio Connections

Digi 002 and Digi 002 Rack each provide up to ten digital inputs and outputs, including:

- Optical input and output for eight channels of ADAT input or two channels of Optical S/PDIF input
- Two channels of S/PDIF digital input and output (RCA connectors)

ADAT Format

The ADAT format was developed by Alesis for use in their ADAT multitrack recorders. Each ADAT optical connection provides eight channels of digital audio with 24-bit capability. You can connect an ADAT or other ADAT optical format device directly to the Optical I/O on the Digi 002 or Digi 002 Rack (see “Connecting an ADAT” on page 66). The optical I/O connectors accept optical cables.

When set for ADAT format, these Optical ports support 44.1 kHz or 48 kHz sample rates only.

S/PDIF

S/PDIF (Sony/Phillips Digital Interchange Format) I/O is available on many DAT decks, compact disc players, and other digital devices. Each S/PDIF connection provides 2 channels of digital audio with 24-bit capability. You can connect a S/PDIF digital input to either the Optical connector or to the S/PDIF RCA connector on the back panel of the Digi 002 or the Digi 002 Rack (see “Connecting a Digital Deck (DAT)” on page 66). The Optical connectors accept standard optical “lightpipe” cables; the RCA connectors accept standard RCA cables.

Both the RCA and Optical ports accept S/PDIF signals at sample rates up to 96 kHz.

Using External Effects Devices

The Digi 002 and Digi 002 Rack can make dedicated connections to external analog or digital devices. You can send and return signals to analog devices using the analog inputs and outputs on the Digi 002 and the Digi 002 Rack. You can also send and return a digital signal to an external device that supports digital I/O (such as a reverb unit), and monitor the return by connecting its analog outputs to available inputs on Digi 002 and Digi 002 Rack.

When you use the digital inputs and outputs on your Pro Tools LE system as effects sends and returns to a digital effects device, Pro Tools LE should be the clock master in most cases. Set your digital effects device to accept an external digital clock so that it synchronizes to Pro Tools LE.

⚠️ Only one S/PDIF input pair can be used at a time. For example, if you use the optical input for S/PDIF data, you cannot use the RCA inputs.
To connect an external analog device to your system:

1. Connect each input of the external signal processor to an available analog output on the Digi 002 or Digi 002 Rack.
2. Connect each output of the external signal processor to an available analog input on the Digi 002 or Digi 002 Rack.

If you plan to use the external device as an Insert in Pro Tools, connect it to inputs and outputs of the same number (for example, Input 5 and Output 5) of Digi 002 or Digi 002 Rack.

To set up a send to an external digital effects device (digital sends/returns only):

1. Connect the digital inputs and outputs of the external signal processor to the appropriate digital connectors (the S/PDIF RCA connectors or the Optical ports) on Digi 002 or Digi 002 Rack.
2. In Pro Tools, choose Setups > Hardware Setup.
3. Under Digital Input, select one of the following options:
   - If the external effects device is connected to the S/PDIF RCA jacks, select “RCA = S/PDIF.”
   - If the external effects device is a S/PDIF device and connected to the Optical ports, select “Optical = S/PDIF.”
   - If the external effects device is an ADAT Optical compatible device, select “Optical = ADAT.”
4. Choose Internal from the Clock Source pop-up menu.
5. Click OK.

You can use the I/O Setup dialog (Setups > I/O Setup) to label the inputs and outputs you are using in Pro Tools LE and identify them as inserts or sends when working in a session. Refer to the Pro Tools Reference Guide for details.

Monitoring and Recording from Alternate Sources

Digi 002 and Digi 002 Rack provide a pair of additional inputs for monitoring and recording from an external sound source such as a CD player or tape deck. This alternate input is equipped with standard RCA connectors and is designed for input signals with a nominal operating level of –10 dBV.

To monitor an alternate sound source through the Digi 002 or Digi 002 Rack Monitor Outputs:

1. Connect the outputs of the external device to the left and right Alternate Source Inputs on the back panel of Digi 002 or Digi 002 Rack.
2. Press the “Alt Src to Mon” switch (located on the top panel of Digi 002, and on the front panel of Digi 002 Rack) to route the signal to the Monitor Output.
3. Adjust Monitor Output or Headphone Output levels to audition the input.

To monitor an external device through the Alternate Source Inputs, Digi 002 or Digi 002 Rack must be powered on.
To record an alternate sound source directly into Pro Tools:

1. Connect the outputs of the external device to the left and right Alternate Source Inputs on the back panel of Digi 002 or Digi 002 Rack.

2. Press the “Alt Src to 7–8” switch (located on the top panel of Digi 002, and on the front panel of Digi 002 Rack) to route the signal directly to Inputs 7–8 in Pro Tools.

When the “Alt Src to 7–8” switch is engaged, Inputs 7 and 8 on the back panel are inactive. Also, because the signal can be monitored from Pro Tools, it no longer passes directly to the Monitor Outputs.

Mirroring the Main Outputs

When using Digi 002 or Digi 002 Rack with Pro Tools, you can send any pair of outputs (such as outputs 1–2) to the S/PDIF digital outputs at the same time by assigning the stereo mix to multiple output destinations. This is commonly known as mirroring the outputs.

Output mirroring is useful for recording to multiple media, creating separate monitoring mixes, or for output to digital effects processors.

To mirror the Digi 002 or Digi 002 Rack Main Outputs on the S/PDIF outputs:

1. Open the Pro Tools session whose channel outputs you want to mirror.

2. In the Mix window, click the Output Selector of any audio or Auxiliary Input track to select the main output destination, for example, Analog 1–2.

3. Hold the Control key and click the same Output Selector again, then select a second output for the same track (for example S/PDIF L-R).

The newly selected destination is indicated by an additional check mark in the output pop-up menu, and a plus sign in the Output Selector.

Choosing multiple output destinations for a track

Chapter 7: Connecting Your Studio
Connecting a Recorder for Mixdowns

After you record and mix your sessions using Digi 002 or Digi 002 Rack, you may want to mix them down to a DAT, audio cassette, or other stereo 2-track recording device.

Connecting an Analog Deck

- If your recorder operates at –10 dBV level, connect its inputs to the Alt Main Outputs on the back of the Digi 002 or the Digi 002 Rack. These outputs are RCA connectors.
- If your recorder operates at +4 dBu level, connect its inputs to the Main Outputs 1–2 on the back of the Digi 002 or the Digi 002 Rack. These outputs are 1/4-inch jacks. You may need adapter cables if your mixdown deck has RCA inputs (and the Alt Main Outputs are not available).

Connecting a Digital Deck (DAT)

If you have a DAT or other digital device that can receive S/PDIF digital audio data, connect it to the S/PDIF In and S/PDIF Out RCA jacks on the back of the Digi 002 or the Digi 002 Rack.

Connecting an ADAT

To connect an ADAT to Digi 002 or Digi 002 Rack:

1. Connect the Optical output on the ADAT to the Optical In port on the Digi 002 or Digi 002 Rack.
2. Connect the Optical input on the ADAT to the Optical Out port on the Digi 002 or Digi 002 Rack. (When the Digi 002 or Digi 002 Rack is on, its Optical Out port emits a red light.)
MIDI Connections

Using the Digi 002 or Digi 002 Rack built-in MIDI ports, a MIDI keyboard controller and MIDI instruments, you can take full advantage of the MIDI features of Pro Tools LE. These include recording and editing MIDI tracks, synchronizing to MIDI Time Code or MIDI Beat Clock (this requires an appropriate MIDI interface) and using a MIDI control surface.

To connect MIDI devices to Digi 002 or Digi 002 Rack:

1. Using standard 5-pin MIDI cables, connect the MIDI Out port of the MIDI device or controller to the MIDI In port of your Digi 002 or Digi 002 Rack.

2. Connect the MIDI In port of your MIDI device or controller to either of the two MIDI Out ports of the Digi 002 or Digi 002 Rack.

3. Connect the audio outputs of your device to available audio inputs of the Digi 002 or Digi 002 Rack.

MIDI In port

MIDI Out ports

See the Digi 002 and Digi 002 Rack Basics Guide for information on basic MIDI concepts.

MIDI ports are only active when Pro Tools is launched.

See Appendix E, “Configuring Midi Studio Setup (Windows Only)” or Appendix F, “Configuring AMS (Mac OS X Only)” for detailed information on how to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.
This tutorial of Pro Tools LE software introduces its main windows and features, and also includes a step-by-step overview of audio recording (see “Basic Recording” on page 81).

All features described in this chapter are explained fully in the Pro Tools Reference Guide.

You can view an electronic PDF version of the Reference Guide by choosing it from the Pro Tools menu.

Session Basics

Pro Tools LE projects are created and saved as sessions. Sessions store all tracks, audio, MIDI, and other session information. Audio and fade files are stored in folders within the session folder.

Starting a Session

To create a new session:

1. Launch Pro Tools LE.
2. Choose File > New Session.
3. In the New Session dialog, set the sample rate, bit depth, and other options for the new session.
4. Select where you want to save your session. If you are using external hard drives with your Pro Tools system, make sure you select the appropriate drive in the New Session dialog.
5 Type a name for your session.  
6 Click Save. The new session opens its Mix, Edit, and Transport windows (see Figure 7 on page 70).

Main Windows

The Mix, Edit, and Transport windows are the main Pro Tools work areas. You can show any of these windows by choosing them from the Windows menu.

- **Mix Window** Displays the Pro Tools mixer, with its familiar fader strip controls for volume, pan, solo, mute, and signal routing.
- **Edit Window** Displays tracks in the session along the Timeline, for editing of audio, MIDI, and automation data.
- **Transport** Provides standard transport controls for Play, Stop, Rewind, Fast-Forward, Pause, and Record. The Transport window can also show Counter and MIDI Control displays.
- **Workspace** The Workspace browser is a DigiBase feature available in Pro Tools 6 and higher. For more information see the DigiBase Guide.

- Press Command+"=" on Macintosh, or Ctrl+"=" on Windows to switch between the Edit and Mix windows.

![Figure 7. Main session windows](image-url)
**Rulers**

Pro Tools LE provides several different rulers to select as the timebase for your session.

Timebase Rulers, displayed along the top of the Edit window, include Bars:Beats, Minutes:Seconds, and Samples. The current timebase determines the format of the Main counter, and provides the basis for the Edit window Grid.

**To select a Timebase Ruler:**

- Click the name of the ruler at the top left side of the Edit window (Bars:Beats, Minutes:Seconds, or Samples).

**Setting a Tempo**

You can set the tempo for your session by using the Song Start Marker, located in the Tempo Ruler.

**To set the session tempo with the Song Start Marker:**

1. In the Tempo Ruler, double-click the Song Start Marker.

2. In the Tempo Change dialog, enter the BPM (beats per minute) value you will use for the session (so the inserted tempo event replaces the default tempo).

3. To base the BPM value on a different note value (such as an eighth-note rather than the default quarter-note), select a note value in the Resolution section.

4. Click OK.

**Using the Click Plug-In**

The Click plug-in creates an audio click during session playback. This works like a metronome that you can use as a tempo reference when performing and recording.

The Click plug-in is synchronized to the tempo and meter of the Pro Tools session, and follows any changes in tempo and meter.

The Click plug-in is one of many plug-ins that can be inserted on a Pro Tools track. See “Plug-Ins” on page 92.
Click Parameters

MIDI In LED Illuminates each time the Click plug-in receives a click message from the Pro Tools application, indicating the tempo.

Accented Controls the output level of the accented beat (beat 1 of each bar) of the audio click.

Unaccented Controls the output level of the unaccented beats of the audio click.

To use the Click plug-in:
1. Choose MIDI > Click to enable the Click option.
   – or –
Select the Click button in the Transport window.

2. Create a mono Auxiliary Input (Aux Input) track.
3. Insert a Click plug-in on the Auxiliary Input track.
4. In the Click plug-in window, choose a click sound from the Librarian pop-up menu (this menu displays “factory default” when you first insert the plug-in).

5. Choose MIDI > Click Options and set the Click and Countoff options as desired. (Click OK to apply these options.)

   The Note, Velocity, Duration, and Output options in this dialog are for use with MIDI instrument-based clicks and do not affect the Click plug-in.

   Refer to the Pro Tools Reference Guide for more information on configuring Click options.

6. Begin playback. A click is generated according to the tempo and meter of the current session and the settings in the Click Options dialog.

Using an External MIDI Click

Pro Tools also provides a MIDI Click option that lets you use an external MIDI device to play a click. This feature can be turned on and off in the Transport window, and is configured from the MIDI Click Options dialog.

To configure and enable an external MIDI click:
1. Choose MIDI > Click Options.

Click/Countoff Options dialog
2 Configure the click parameters as needed for your MIDI sound source.

3 Select the desired MIDI sound source from the Output pop-up menu and click OK.

4 During recording or playback, you can turn the Click on or off with the Click button in the MIDI Controls display of the Transport window.

To save a session:

- Choose File > Save Session, Save Session As, or Save a Session Copy In.

**Save Session** Saves the currently open session file, leaving it open for you to continue working.

**Save Session As** Creates a duplicate session file with the name you choose, and leaves the duplicate open for you to continue working. It does not create a new Audio Files or Fade Files folder. This can be useful if you want to experiment with different arrangements in the session without affecting the original session.

**Save Session Copy In** Saves copies of the session file and the files that you are using in the current session. This can be useful for creating a final copy of the session that does not include audio files or fades you are no longer using.

### System Resources and Settings

You can change specific Pro Tools system settings to optimize system performance.

#### Playback Engine Dialog

The Playback Engine dialog lets you adjust system buffer sizes and allocate CPU processing power to Pro Tools.

To configure system resources:

- Choose Setups > Playback Engine.

**For Windows systems, see Chapter 2, “Windows Configuration.” For Macintosh systems, see Chapter 3, “Macintosh Configuration.”**
System Usage Window

The System Usage window displays approximate information on CPU load, DSP usage, and (on Macintosh systems only) overall disk performance, so you can gauge your system’s processing capacity.

To view system resources and usage:
- Choose Windows > Show System Usage.

Transport Controls

The Transport window provides access to all Pro Tools LE transport commands. Different transport controls can be displayed or hidden in this window.

To show the Transport window:
- Choose Window > Show Transport Window.

To configure the Transport window:
- Choose Display > Transport Window Shows and select view options.

The Transport window provides Play, Stop, and other standard transport controls.

The Expanded view of the Transport window provides pre- and post-roll, start, end, and length indicators for Timeline selection, as well as the Transport Master selector.

The Transport window can also display the following MIDI controls: Wait for Note, Click, Countoff, MIDI Merge, Conductor, Meter, and Tempo.

To start and stop playback:
1. Click Play in the Transport window to begin playback.
2. Click Stop in the Transport window to stop playback.

Press the Spacebar on your computer keyboard to start and stop playback.

Pro Tools LE starts playing from the location of the cursor, or from the beginning of the current selection. The current setting of the Link Edit and Timeline Selection command in the Operations menu also affects playback. See the Pro Tools Reference Guide for more information.
Tracks
You can create audio and MIDI tracks for audio and MIDI recording, submixing, routing, automating, and editing.

Pro Tools provides four types of tracks: audio tracks, Auxiliary Inputs, Master Faders, and MIDI tracks. Audio tracks, Auxiliary Inputs, and Master Faders can be mono or stereo.

Audio Tracks Record and play back audio to and from hard disk, monitor audio input when record-enabled, and edit audio regions

Auxiliary Inputs Audio mixer channels, used for input, routing, and submixing

Master Faders Provide master channel controls and options for any output or bus path

MIDI Tracks Record, play back, and edit MIDI data

To create a new track:


2. Specify the number of tracks, track type, and mono or stereo (for all types except MIDI).

3. Click Create.

In the Mix window, audio tracks, Auxiliary Inputs, Master Faders, and MIDI tracks appear as vertical channel strips.

Track type is indicated by the Track Type icons just below the faders.
Audio tracks, Auxiliary Inputs, Master Faders, and MIDI tracks can be automated.

**Inserts** Inserts on Master Faders are post-fader only. (Audio track and Aux input track inserts are all pre-fader.)

**Sends** Master Faders do not provide sends. To send an output to another destination, use an Auxiliary Input.

**MIDI Tracks**

MIDI tracks provide volume, solo, and mute, in addition to MIDI input, output, channel, and program (patch) controls. MIDI volume, mute, and pan can also be automated using Pro Tools automation features (see “Mix Automation” on page 93 for more information).

**Regions Lists**

A region is a piece of audio or MIDI data that can also have associated automation data. For example, a region could be a loop, a guitar riff, a verse of a song, a sound effect, a piece of dialog, or an entire sound file. In Pro Tools, regions are created from audio or MIDI files, and can be arranged in audio and MIDI track playlists.

All regions that are recorded, imported, or created by editing appear in the Audio and MIDI Regions Lists. Regions can be dragged from either list to tracks and arranged in any order. Audio regions can also be auditioned from the Regions Lists by Option-clicking the audio region name. The Regions List pop-up menus provide features for managing regions and files (such as sorting, selecting, importing, or exporting files).

![Stereo audio track in the Mix window](image)
Navigating in a Session

Pro Tools LE provides many ways to navigate in a session, including using the mouse or entering a memory location into one of the counters.

To navigate to a location in the Edit window:
1. In the Operations menu, make sure Link Edit and Timeline Selection is enabled.
2. Enable the Selector tool at the top of the Edit window by clicking it.
3. Click in a track or Timebase Ruler. The cursor appears at the selected location and the counters display the current time location.

Audio and MIDI Regions Lists

For more information on Regions Lists, refer to the Pro Tools Reference Guide or the DigiBase Guide.

Clicking with the Selector in the Edit window

To navigate using the counters:
1. Click in the Main counter and enter a location using your computer keyboard.
2. Press Enter (Windows) or Return (Macintosh).

Navigating with the Counter

Press the * key on the numeric keypad as an alternative to clicking in the counter. (The cursor will always appear in the Transport window’s Main Counter if it is displayed.)
Memory Locations

Memory Locations provide another way to navigate within sessions. Memory Locations appear as markers under the Timebase Rulers.

To define a memory location:

1. Navigate to the location at which you want to store a marker or memory location.
   - or -
2. Begin playback.
3. Press Enter on the numeric keypad while stopped or during playback (or click the Markers icon).

In the New Memory Location window, you can define a marker, store a selection, or store any combination of the other available settings. These settings include track height, group enabes, pre- and post-roll values, and track Show/Hide status.

4. Choose settings for the memory location and click OK.

To go to a stored memory location:

1. Choose Windows > Show Memory Locations.
2. In the Memory Locations window, click the name of the memory location.

Viewing and Zooming

When viewing tracks in the Edit window, you can adjust the height of tracks as well as zoom in vertically and horizontally using the Track Height selector and Zoom tools.

To change track height:

- Click the Track Height Selector, and select a track height from the pop-up menu.

💡 You can apply many commands, including track height selection, to more than just a single track. Hold down the Alt key (Windows) or Option key (Macintosh) while performing an operation to apply it to all tracks. Hold down both the Shift and Alt keys (Windows) or Shift and Option keys (Macintosh) while performing an operation to apply it to all selected tracks.
To Zoom in or out on any area of a track in the Edit window:

1. Click to select the Zoomer.
2. Click or drag with the Zoomer to zoom in horizontally for a track or Ruler.
   – or –
   Press Option and click or drag with the Zoomer to zoom out horizontally for a track or Ruler.

To zoom in or out incrementally:

- Click the appropriate Zoom button:
  • Left Arrow (Horizontal Zoom Out)
  • Right Arrow (Horizontal Zoom In)
  • Waveform and MIDI buttons, to increase or decrease vertical zoom of the appropriate track type (audio or MIDI)

Pro Tools also provides five Zoom preset buttons. You can use these to immediately return to established zoom levels; you can define the magnification level for each preset, on a session-by-session basis.

To use a stored Zoom preset:

- Click the appropriate Zoom preset 1–5.

To store a new Zoom preset definition:

- Command-click a Zoom preset number to store the current horizontal and vertical Zoom to that preset.

Using Memory Locations for Zoom Control

Pro Tools Memory Locations let you store many attributes with each marker or memory location, including Track Height and Zoom Settings. By creating Memory Locations that are neither Markers nor Selections, but have Track Height, Zoom Settings, or other options enabled, you can use Memory Locations to zoom in and out using just the numeric keypad.

For more information on creating memory locations, see “Memory Locations” on page 78.

Importing Audio

Pro Tools LE lets you import existing audio files from disk. This is very useful if you have audio files already recorded to disk or if you are working with CD-based sample libraries that you want to use in a new session.

To import audio files or regions from disk:

- Choose File > Import Audio to Track to import files and regions to new audio tracks (they will also appear as regions in the Audio Regions List).
  – or –
- Choose Import Audio from the Audio Regions List pop-up menu to import files and regions to the Audio Regions List only.

For more information on importing audio into sessions, refer to the Pro Tools Reference Guide.

To import a CD audio track:

1. Put the source CD into your computer’s CD drive.
2. Use a third party software program of your choice to extract audio from the CD.
3 In the session, create a new track by choosing File > New Track.

4 In the New Track dialog, specify 1 Stereo Audio Track, and click Create.

5 Open the Workspace Browser by choosing Windows > Show Workspace. The Workspace Browser is a window where you can find, audition, and manage your audio files.

6 In the Workspace Browser, navigate to the location where you saved the audio you extracted from your CD in step 2.

7 You can audition the audio file by clicking on the speaker icon in the waveform window.

8 Drag the audio file from the Workspace Browser to the audio track you created in your session.

If you are running Pro Tools on Mac OS X, you can import audio using the Movie > Import Audio From Other Movie command. For more information, see the Pro Tools Reference Guide.

DigiBase provides additional options for importing audio. See the DigiBase Guide for more information.
Basic Recording

This section describes how to record audio and MIDI into Pro Tools LE.

Preparing for Recording

To route audio to a track:

1. Verify the connections to your instruments.

2. Create a new track to record on by choosing File > New Track. Specify 1 Mono Audio Track and click Create.

3. In the Mix window, click the Input Selector on the new track.

4. From the pop-up menu, select the input you want to record. For example, select Mic/Line 1 if your audio source is plugged into the Mic 1 or Line/Inst 1 jack on the back of Digi 002 or Digi 002 Rack. (This input is listed as Mic/Line 1, or as the name defined in the I/O Setup dialog.)

Setting Digi 002 or Digi 002 Rack Input Levels

Input levels for Mic/Line 1–4 are adjustable using the gain knobs (located on the top panel of the Digi 002, and on the front panel of the Digi 002 Rack). Input levels for all other inputs on Digi 002 or Digi 002 Rack cannot be adjusted in Pro Tools, and need to be set at the source.

The key to setting input levels is to get the peak of the signal as loud as possible while retaining sufficient headroom to avoid digital clipping. Signals that get close to the top of the meter in Pro Tools LE use more of the full bit range (the 16 or 24 bits that make up each audio sample). The more you maximize this bit range, the better your sound quality. In addition, by setting optimum levels, you’ll get the lowest possible noise and distortion.

Set levels to avoid digital clipping. Clipping occurs when you feed a signal to an audio device that is louder than the circuitry can accept, resulting in distortion. Digital clipping is indicated by the red clip light at the top of the Pro Tools on-screen meters.

To adjust input gain on Mic/Line inputs 1–4:

1. Connect an audio source to the appropriate input connector on the back panel of Digi 002 or Digi 002 Rack. Microphones should be plugged into an XLR connector. Line inputs or instruments should be plugged into a 1/4-inch TRS connector.

2. Press the Mic/Line/Instrument Selector switch (located on the top panel of the Digi 002, and on the front panel of the Digi 002 Rack) to match the type of device you connected.

3. If you connected a microphone that requires phantom power, apply phantom power now by pressing the 48V switch on the back panel of the Digi 002 or Digi 002 Rack.
4 Choose File > New Track and specify 1 Mono Auxiliary Input track, then click Create.

5 Set the track input to the correct Digi 002 or Digi 002 Rack input channel (Mic/Line 1–4).

6 Play the instrument or sound source at the volume you will record.

7 Adjust the input gain for the channel using the gain knob (located on the top panel of the Digi 002, and on the front panel of the Digi 002 Rack). Increase or decrease gain until you are able to achieve maximum peak levels in the Auxiliary Input track meter without clipping. Typically such peak levels are in the yellow area of the meter.

**Optimizing Gain Structure**

In order to maximize the dynamic range and signal-to-noise ratio of your recording, you'll want to apply the correct gain at each stage of your audio chain.

- With microphones, place the mic close enough to the source to maximize input levels, but far enough away to avoid proximity effect, then set the input gain on Digi 002 or Digi 002 Rack.

- With line inputs and instrument direct inputs, raise the input level to achieve as strong a signal as possible without excessive noise, then set the input gain on Digi 002 or Digi 002 Rack.

**Mic/Line High-Pass Filters**

Mic/Line Inputs 1–4 include a high-pass filter set at 75 Hz. This filter can be useful for filtering out low-end rumble from a noisy recording environment, microphone handling, or AC noise.

**Recording an Audio Track**

To record an audio track:

1 Assign the input for a track and set its input levels appropriately.

2 Click the Record Enable button for a track.

3 Choose Windows > Show Transport to display the Transport window.
4 Click Return To Zero to start recording from the beginning of the session. You can also record according to a selection or from the cursor location in the Edit window.

5 Click Record in the Transport window to enable recording.

6 Click Play or press the Spacebar to record on all record-enabled tracks.

7 Record your performance.

8 Click Stop in the Transport window or press the Spacebar when you are finished recording.

To play back a recorded track:

1 Click the track’s Record Enable button a second time to take it out of Record mode.

2 Click Play in the Transport window or press the Spacebar to start playback.

3 Click Stop in the Transport window or press the Spacebar to stop playback.

Recording To and From Digital Devices

Digi 002 and Digi 002 Rack provide both S/PDIF (RCA) digital input connectors and Optical connectors for transfer of digital audio.

Setting Digital Format and Clock Source

Before recording from a digital source, make sure you have enabled the appropriate Digital Format in the Hardware Setup dialog. For more information, see “Recording a Digital Source” on page 17 for Windows or “Recording a Digital Source” on page 28 for Macintosh.

Recording To and From an ADAT

You can use Digi 002 or Digi 002 Rack to interface with an ADAT, either to record tracks from an ADAT into Pro Tools LE for editing, or to record tracks from Pro Tools LE to an ADAT.

To record ADAT tracks into Pro Tools LE:

1 Open or create a session in Pro Tools LE.

2 Record enable up to eight audio tracks (depending on how many tracks are used on the ADAT tape).

3 Assign ADAT Optical Inputs 1–8 to your eight tracks.

4 Verify that Pro Tools LE is synchronized to Optical, and that the Optical Format is set to ADAT.

5 Click Record in the Transport window.

6 Click Play in the Transport window to begin recording, then press Play on the ADAT.

7 When playback from the ADAT tape is finished, click Stop in the Transport window, or press the Spacebar.

To record Pro Tools LE tracks to an ADAT:

1 Open the session you want to record to ADAT.

2 Record enable up to eight audio tracks on the ADAT.

3 Route the output of up to eight audio tracks in Pro Tools to the Optical outputs on Digi 002 or Digi 002 Rack.

4 Verify that Pro Tools LE is referencing its Internal Clock Source in the Hardware Setup dialog.
5 Start recording on the ADAT, then click Play in the Transport window in Pro Tools LE. When playback is complete, stop both systems.

For detailed information on connecting an ADAT to your system, see “Connecting an ADAT” on page 66.

Monitoring Latency and Recording
Because Pro Tools LE uses the host processor in your computer for audio processing, playback, and recording, there is a small amount of audio delay, or latency, when monitoring audio through the system. You can set the latency to be shorter when you are recording and monitoring through Digi 002 or Digi 002 Rack, and longer when you are trying to achieve higher track counts with more plug-ins.

Set latency in the Playback Engine dialog. Latency is controlled by the H/W Buffer Size setting, and is displayed in samples. The recommended setting for listening back to audio is 512–1024 samples. For recording, when monitoring through Digi 002 or Digi 002 Rack, the recommended setting is 128–256 samples.

To set the Hardware Buffer Size for record or playback:
1 Choose Setups > Playback Engine.
2 Choose the number of samples from the H/W Buffer Size pop-up, then click OK.

Low Latency Monitoring
Pro Tools LE includes a feature called Low Latency Monitoring for Digi 002 or Digi 002 Rack systems. This feature allows you to use a built-in mixer in the Digi 002 unit or Digi 002 Rack unit to record and monitor up to 18 inputs (8 analog, 8 ADAT, and 2 RCA-S/PDIF) with extremely low latency. This mode is useful for recording multiple instruments at the same time.

To use Low Latency Monitoring, tracks must be record-enabled, assigned to an actual audio input (not a bus), and assigned to outputs 1 or 2.

To enable Low Latency Monitoring:
■ Select Operations > Low Latency Monitoring.

When Low Latency Monitoring is enabled, any plug-ins and sends assigned to record-enabled tracks (routed to Outputs 1–2) are automatically bypassed, and must remain bypassed. Also, these tracks will not register on meters for Master Faders.

Recording MIDI
To configure a MIDI track for recording:
1 For Macintosh systems, choose MIDI > Input Devices and make sure your input device is selected in the MIDI Input Enable window. Click OK to apply your changes.
2 Choose File > New Track and specify 1 MIDI Track, then click Create.
In the Mix window, click the track’s MIDI Output Selector and choose the destination (assignment) for that MIDI track by choosing a MIDI interface port, a channel, or a device from the pop-up menu. Choices vary depending on the operating system, Pro Tools version, and the hardware and instruments you have connected.

You can assign a default program change to the track by clicking on the Program button in the Mix window and making the necessary selections for program and bank select, and then clicking Done. Default program changes are sent when playing a track.

In the Mix Window, record-enable the MIDI track.

Make sure MIDI > MIDI Thru is selected, then play some notes on your MIDI controller. The MIDI instrument assigned to the track should sound, and the track’s meters should register MIDI activity.

To record onto a MIDI track:

1. Verify that the MIDI track you want to record to is record-enabled and receiving MIDI.

2. In the Transport window, click Return To Zero to start recording from the beginning of the session. You can also record according to a selection or from the cursor location in the Edit window.

3. Click Record in the Transport window.

4. Click Play in the Transport window or press the Spacebar to begin recording.

– or –

If using Wait for Note, the Play, Record, and Wait for Note buttons flash. Recording begins when the first MIDI event is received.

– or –

If using Countoff, click Play. The Record and Play buttons flash during the Countoff, then recording begins.

5. Play your MIDI instrument.

6. When you have finished recording, click Stop in the Transport window, or press the Spacebar. The newly recorded MIDI data appears as a MIDI region on the track in the Edit window, as well as in the MIDI Regions List.

To play back a recorded MIDI track:

1. Click the Record Enable button to take the MIDI track out of Record mode.

2. In the Transport window, click Return To Zero to play back from the beginning of the track. You can also play back according to a selection or from the cursor location in the Edit window.

3. Click Play in the Transport window to begin playback. The recorded MIDI data plays back through the track’s assigned instrument and channel.
Monitoring MIDI Instruments Without a Mixer

To monitor your MIDI instrument’s analog output, you can use an Auxiliary Input. Auxiliary Inputs function as inputs for both internally bussed signals and external audio sources.

To configure an Auxiliary Input for MIDI monitoring:

1. Connect the MIDI instrument’s audio output to the appropriate inputs on your Digi 002 or Digi 002 Rack.
2. Choose File > New Track and specify 1 mono or stereo Auxiliary Input, then click Create.
3. Click the Input selector of the Auxiliary Input channel and choose the input to which your MIDI instrument is connected.
4. Adjust the level of the Auxiliary Input with its volume fader.

QuickPunch Recording

With QuickPunch recording you can punch in and out of audio recording on armed tracks. Recording can be triggered from the Transport window, or using a standard footswitch. You can use a standard footswitch (such as a keyboard sustain pedal) with QuickPunch to punch in when recording audio. You can also punch in when recording MIDI, without enabling QuickPunch.

For more information on QuickPunch and punch recording, see the Pro Tools Reference Guide.

To connect a footswitch to Digi 002 or Digi 002 Rack:

1. Turn off the Digi 002 or Digi 002 Rack unit.
2. Plug the footswitch into the Footswitch connector on the back panel of Digi 002 or Digi 002 Rack.
3. Power on the Digi 002 or Digi 002 Rack unit.

Footswitch polarity is detected by Digi 002 or Digi 002 Rack firmware when you power up the unit. Make sure the footswitch is connected and not pressed when turning on the Digi 002 or Digi 002 Rack.

To punch in with QuickPunch when recording audio:

1. Select Operations > QuickPunch.
2. Set input routing and click the Record button on each audio track you want to punch in. You can punch in on up to 8 audio tracks while playing back 32 tracks, or you can punch in on up to 16 tracks while playing back 24 tracks.
3. Click Play in the Transport window.
4. Click Record in the Transport window or step on the footswitch to begin recording (punch in) on all record-enabled tracks.
5. Click Record in the Transport window or step on the footswitch again to stop recording (punch out).

Note that the session continues to play, and you can continue to punch in and out as many times as you want.

With QuickPunch enabled, press Ctrl+Spacebar (Windows) or Command+Spacebar (Macintosh) to punch in and punch out.
To punch in when recording MIDI:

1. Set your MIDI input routing and click the Record button on each MIDI track you want to punch in. QuickPunch is not required to punch in on MIDI tracks.

2. Click Play in the Transport window.

3. Click Record in the Transport window or step on the footswitch to begin recording (punch in) on all record-enabled tracks.

4. Click Record in the Transport window or step on the footswitch again to stop recording (punch out).

Editing

Pro Tools LE provides several tools for editing audio and MIDI. In the Edit window, audio and MIDI tracks can be edited into regions or repeated in different locations, to create loops, rearrange sections or entire songs, or to assemble tracks using material from multiple takes.

Edit Modes

Pro Tools LE has four Edit modes: Shuffle, Spot, Slip, and Grid. The Edit mode is selected by clicking the corresponding button in the upper left of the Edit window.

Press F1 (Shuffle), F2 (Slip), F3 (Spot), and F4 (Grid) to set the Edit mode.

The Edit mode affects the movement and placement of audio and MIDI regions (and individual MIDI notes), how commands like Copy and Paste function, and also how the various edit tools (Trimmer, Selector, Grabber, and Pencil) work.

For detailed descriptions of Edit modes, refer to the Pro Tools Reference Guide.
**Edit Tools**

Pro Tools LE has seven Edit tools: Zoomer, Trimmer, Selector, Grabber, Scrubber, Pencil, and Smart Tool. Select an Edit tool by clicking it in the Edit window. The Zoomer, Trimmer, Grabber, and Pencil tools have multiple modes, which you can select from a pop-up menu when you click the tool.

**Trimming Regions**

After recording an audio track, you will have an audio region on that track. If there is some silence at the beginning of the region, or there is some extra audio at the end of the region, you can use the Trimmer tool in Slip mode to shorten the beginning or end of the region.

1. Select Slip mode.
2. Select the Trimmer tool.
3. Move the cursor near the beginning of the audio region (notice the cursor displays as a “[“).
4. Click at the beginning of the region and drag right to shorten the region.
5. Move the cursor near the end of the audio region (notice the cursor displays as a “]”).

---

*For detailed descriptions of the Edit Tools, refer to the Pro Tools Reference Guide.*

---

*Press the Escape key to toggle through the Edit tools.*

---

*Audio region on a track*

*Trimming the beginning of a region*

*Trimming the end of a region*
6 Click at the end of the region and drag left to shorten the region.

The trimmed region

You can also extend a region using the Trimmer tool if there is audio data beyond the current boundaries of the region. If extending the region’s beginning, drag to the left; if extending the region’s end, drag to the right.

Arranging Regions

There are many ways to edit and arrange regions; the following example demonstrates how you might create and arrange a drum loop to compose a rhythm track.

To create and arrange a rhythm sequence:

1 Open or create a session in Pro Tools LE.
2 Specify the session meter (MIDI > Change Meter) and tempo (MIDI > Change Tempo).
3 Select Grid mode.
4 Prepare to record using a MIDI click (see “Using the Click Plug-In” on page 71 or “Using an External MIDI Click” on page 72).
5 Record a drum track (see “Recording an Audio Track” on page 82) keeping in mind that you want to use only the best bar (measure). Your recording should fit the grid at the specified tempo and meter.
   – or –
Import an existing audio file, such as a drum loop from a sample library, and place it on an audio track (see “Importing Audio” on page 79).

6 Click the Selector tool, and drag on the waveform with the Selector to make a one-bar selection. Note that the selection snaps to the specified grid.

Making a selection in Grid mode

7 Create a new audio track (File > New Track).
8 From the Grabber pop-up menu, select the Separation Grabber tool.
9 With the Separation Grabber tool, drag the selection to the beginning of the new audio track. A new region is created and appears at the beginning of the new track.

Dragging a selection with the Separation Grabber tool

10 With the new region still selected, choose Edit > Repeat.

Repeat dialog

11 In the Repeat dialog, enter a number of repeats, and click OK.

You now have a new rhythm track with a “looped” (repeated) phrase. You can use these editing tools to do much more advanced and involved editing of regions. For example, you
could separate beats or “hits” into individual regions and rearrange them in Grid or Shuffle mode as a way of coming up with new and interesting rhythms.

**Playlists and Nondestructive Editing**

Playlists let you create and retrieve multiple versions of track edits. A playlist can be a complete take, an overdub, or an arrangement of selections from multiple takes. You can duplicate playlists to save edits in their current state, then continue making additional edits to the new playlist knowing you can always go back to the previous version.

**To create multiple playlists for editing:**

1. Start with a track on which you want to try different edits.
2. From the Playlist Selector pop-up menu, choose Duplicate.
3. Name the duplicated playlist and click OK.
4. Make your first series of edits.
5. Return to the original playlist by selecting it from the Playlist Selector pop-up menu.
6. Repeat steps 2–5 for any further edits.

In this way, you can try out different edits of a track, and switch back and forth between playlists for comparison.

**Mixing**

The Pro Tools mix environment provides many familiar channel strip controls for setting volume, pan, solo, and mute. Mixer and I/O controls can be shown in both the Mix and Edit windows.

**To view the Mix window:**

- Select Windows > Show Mix.

  > Press Control+Equals (=) in Windows or Command+Equals (=) on Macintosh to switch between the Edit and Mix windows.

**Using Channel Strip Controls**

**Volume** Increase or decrease the track level by dragging its Volume fader up or down.

**Pan** Pan a track left or right in the mix by dragging its Pan slider left or right.

**Solo** Solo a track (muting all other tracks) by clicking its Solo button.

**Mute** Mute a track by clicking its Mute button.

**Basic Signal Routing**

Signal routing is accomplished by assigning track inputs and outputs. Audio track inputs can be from any hardware input or bus path. Once recorded, an audio track’s input is its audio file on disk. Auxiliary Inputs can be any hardware input or internal bus path. For all types of audio tracks, outputs can be routed to any hardware output or internal bus path.
You can use these signal routing features to set up virtually any mixer architecture for your projects, including sends and returns for effects processing and submixing.

Send and Return Submixing for Effects Processing

When you are submixing for reverb, delay, and similar effects processing, you can use sends and Auxiliary Inputs to achieve traditional send/return bussing. You can use a real-time plug-in (see “Plug-Ins” on page 92) as a shared resource for all tracks included in a submix. The wet/dry balance in the mix can be controlled using the track faders (dry level) and Auxiliary Input fader (wet, or effect return level).

Creating a Send

Pro Tools LE provides up to five sends per audio track. A send can be mono or stereo, routing to an output or one of 16 internal bus paths.

To assign a send on a track:

1. Make sure Sends View is enabled in the Mix window (Display > Mix Window Shows > Sends View).
2. Click the Sends button on an audio track and choose a path from the pop-up menu.
3. Set the output level of the send. You can set the send level to zero by Option-clicking the send fader.

💡 You can configure the default level for new sends to be \(-\infty\) or at unity gain (0 dB) by enabling or disabling the Sends Default To “\(-\infty\)” option under the Operation Preferences.

Creating a Return

Auxiliary Inputs can be created to act as return channels for busses, as well as for inputs from hardware sources.

To create a return:

1. Choose File > New Track and specify 1 mono or stereo Auxiliary Input, then click Create.

Assigning a send to a stereo bus path

Audio and Auxiliary Input tracks configured for a send and return

To create a return:
2 Click the Input Selector of the Auxiliary Input and set it to the bus path you assigned to the sends on the source tracks.

3 Click the Output Selector of the Auxiliary Input and choose an output path.

Master Faders

Master Faders are used as output and bus masters, and can control any mono or stereo output or bus path in a session. You can then use the controls on the Master Fader to control the volume, solo and mute, or apply inserts to those paths.

When you are mastering your final mix, it is recommended that you use a dither plug-in on the Master Fader controlling your main outputs (for more information on dither, see the Pro Tools Reference Guide).

To create a Master Fader:

1. Choose File > New Track and specify 1 mono or stereo Master Fader track, then click Create.

2. In the Mix window, click the Master Fader’s Output Selector and choose the output path that you want to control. You can choose either outputs or internal busses.

To use a Master Fader as a master stereo volume control for all tracks in a session:

1. Choose File > New Track and specify 1 stereo Master Fader track, then click Create.

2. Set the outputs of all audio tracks in the session to outputs 1–2 and set the panning of each track.

3. Set the output of the Master Fader to your main output path (outputs 1–2).

Plug-Ins

Plug-ins provide EQ, dynamics, delays, and many other types of effects processing. Plug-ins function either in real time or in non-real time.

RTAS plug-ins are nondestructive effects, which are inserted on tracks to process audio in real time—just like an external hardware processor (during playback).

AudioSuite plug-ins are used to process and modify audio files on disk, rather than non-destructively in real time. Depending on how you configure a non-real-time AudioSuite plug-in, it will either create an entirely new audio file, or alter the original source audio file.
Real-time plug-ins are assigned to tracks from the Inserts view in the Mix or Edit windows. Once assigned to a track, plug-ins appear in the track’s Inserts view, and can be opened by clicking the Insert button.

To insert a real-time plug-in on a track:

1. Make sure the Inserts View is shown in the Mix or Edit window.
2. Click the Insert Selector on the track and select the plug-in that you want to use.

Pro Tools comes with a complete set of DigiRack plug-ins, and many more are available from Digidesign and our Development Partners.

For more information about plug-ins, see the DigiRack Plug-Ins Guide.

Mix Automation

Mix automation lets you record, or automate, changes to track and send levels, mutes, pan, and plug-in parameters. MIDI tracks provide volume, pan, and mute automation only.

To write automation:

1. In the Automation Enable window (Windows > Show Automation Enable), enable an automation type (volume, pan, mute, send level, send pan, send mute, or any plug-in automation).
2. Select an automation mode for the tracks to be automated (Write, Touch, or Latch mode).
3. Start playback and begin writing automation by adjusting faders and other controls during playback. Pro Tools LE remembers all moves performed on enabled parameters.
Once written, automation can be re-written or displayed and edited graphically in the Edit window.

---

**Final Mixdown**

The Bounce to Disk command lets you write a final mix to disk, create a new loop, print effects, or bounce any submix. Once you have bounced your final mix to disk, you can use another program to burn the resulting file to Compact Disc.

When you bounce a track to disk, the bounced mix includes the following:

**Audible Tracks** All audible tracks are included in the bounce. Any muted tracks do not appear in the bounce. If you solo a track or region, only the soloed elements appear in the bounced mix.

**Automation** All read-enabled automation is played back and incorporated in the bounced mix.

**Inserts and Sends** All active inserts, including real-time plug-ins and hardware inserts, are applied to the bounced mix.

**Selection or Track Length** If you make a selection in a track, the bounced mix will be the length of the selection. If there is no selection in any track, the bounce will continue until it reaches the end of the session.

To Bounce to Disk:

1. Choose File > Bounce to Disk.
2. Select any mono or stereo output or bus path as the source for the bounce.
3. Select the File Type (such as WAV), Format (such as mono or stereo), Resolution (such as 16-bit), and Sample Rate (such as 44.1 kHz).
4. Click Bounce.

**Using Dither on Mixdown**

You should use a dither plug-in when using the Bounce To Disk command, or when mastering to an external device. Bounce to Disk does not automatically apply dither. To dither a bounce file, insert an included Digidesign Dither plug-in, or another dither plug-in, on a Master Fader assigned to the bounce source path. Master Faders are often preferable to Auxiliary Inputs because Master Fader inserts are post-fader (which is better for dither applications).

For more information on using dither, refer to the Pro Tools Reference Guide.
In addition to its function as an integrated front end and control surface for Pro Tools, Digi 002 can operate as a stand-alone digital mixer in a variety of settings. Figure 9 shows Digi 002 as the hub of a small studio setup, with analog audio and digital audio. Figure 10 shows Digi 002 in a small live performance setup.

See Chapter 7, “Connecting Your Studio” for details on analog audio, and “Digital Audio Connections in Stand-Alone Mode” on page 98 for details on making digital audio connections to Digi 002.

![Diagram of Digi 002 stand-alone studio configuration]
The stand-alone mixing and processing capabilities of Digi 002 are provided by a powerful built-in digital signal processor (DSP). The Digi 002 unit does not need to be connected to a computer to operate in Stand-alone mode. See Appendix G, “Digi 002 Stand-Alone Block Diagram” for an overview of signal flow in Stand-alone mode.

**Overview**

When operating in Stand-alone mode, Digi 002 is a 8x4x2 digital mixer, consisting of:

- Eight inputs corresponding to Analog Inputs 1–8 on the Digi 002 back panel, controlled by the eight channel strips on the top panel
- Dedicated, in-line three-band EQ on input channels 1–8
- Dedicated, in-line compressor on input channels 1–4
- Four available sends on each channel, for adding internal Delay or Reverb effects, or for integrating external effects processors
- A stereo output corresponding to Main Outputs 1–2 on the Digi 002 back panel

**Digital Mixer Sample Rate**

In Stand-alone mode, Digi 002 functions as a digital mixer with a nominal sample rate of 44.1 kHz. Analog input signals are converted to digital signals for processing and mixing.

In Stand-alone mode, Digi 002 supports digital inputs at sample rates up to 48 kHz.

**Mixer Inputs**

**Inputs 1–4** These inputs accept microphone-, line-, or instrument-level signals, and provide variable gain with the Input Gain control on the Digi 002 top panel.
Phantom power is available to Inputs 1–4, in channel pairs, using the Phantom Power switches on the back panel of Digi 002.

**Inputs 5–8** These inputs accept line-level signals and are switchable between −10 dBV and +4 dBu with the operating level switches on the Digi 002 back panel.

**Alt Src Inputs** These inputs are active in Stand-alone mode, allowing you to connect and monitor alternate audio sources such as CD players or tape decks. The signal from the Alt Src Inputs can be routed directly to the Monitor and Headphone Outputs (by pressing the Alt Src to Mon switch) or to Input channels 7–8 (by pressing the Alt Src to 7–8 switch).

When Alt Src to 7–8 is enabled, analog inputs 7–8 (1/4-inch TRS connectors on the back panel of Digi 002) are disabled.

**S/PDIF Digital Inputs** In Stand-alone mode, you can activate these digital inputs so that they appear on inputs 5–6, allowing you to bring a stereo digital signal into the Digi 002. (See “Digital Audio Connections in Stand-Alone Mode” on page 98.)

**Sends**

Each of the eight channels of Digi 002 can send to any or all of the four available sends at the same time. Sends can be either pre- or post-fader.

- **Send A** Routes the input signal to the internal Delay processor
- **Send B** Routes the input signal to the internal Reverb processor
- **Send C** Routes the input signal to output 7 on the back panel of Digi 002
- **Send D** Routes the input signal to output 8 on the back panel of Digi 002

- All the send assignments in Stand-alone mode are fixed, and cannot be changed.

**Dynamics**

Input channels 1–4 have a dedicated, in-line compressor, with controls for the following parameters:
- Input gain
- Threshold
- Compression ratio
- Attack and release times
- Hard or soft knee (slope)
- Phase inversion
- Output gain

**EQ**

Each of the eight Input channels has a dedicated, in-line 3-band equalizer, consisting of the following:
- Switchable high pass/low shelf EQ band
- Parametric EQ band
- Switchable low pass/high shelf EQ band

These EQ bands can be used in conjunction with the built-in hardware high-pass filters available on Inputs 1–4.

**Mixer Outputs**

**Main Outputs** In Stand-alone mode, all eight Input channels, the Delay return, and the Reverb return are summed to outputs 1–2, which are routed to the Main Outputs, Alt Main Outputs, and the S/PDIF outputs on the back panel of Digi 002. Outputs 1–2 are also mirrored on the Monitor Outputs and Headphone Output.
ADAT Optical Outputs In Stand-alone mode all eight Input channels are passed directly to the eight ADAT Optical Outputs, pre-fader, pre-effects, except for the high-pass filter on channels 1–4. This allows you to route input signals directly to an ADAT device without repatching cables.

Digital Audio Connections in Stand-Alone Mode

Digital Inputs

In Stand-alone mode, you can set Inputs 5–6 to accept S/PDIF digital input instead of analog input.

When Inputs 5–6 are set to S/PDIF, the 1/4-inch analog connectors for Inputs 5–6 (on the back panel of Digi 002) are inactive.

To set Inputs 5–6 to S/PDIF digital input:

1. In Stand-alone mode, press the Utility (F1) switch.
2. Press the illuminated Channel Select switch under Pref.
3. Press the illuminated Channel Select switch under In56 (Inputs 5–6).
4. Press the illuminated Channel Select switch repeatedly to toggle Inputs 5–6 to Analog or S/PDIF.
5. Press the Escape (Esc) switch to exit Input 5–6 preferences.
6. Press the far right-hand Channel Select switch to save the preference settings.
7. Press the Escape (Esc) switch twice to exit Utility mode.

Entering Stand-Alone Mode

You can put Digi 002 into Stand-alone mode when the unit is in Standby mode or in Pro Tools mode. However, if Digi 002 is in Pro Tools mode when you put it in Stand-alone mode, communication with Pro Tools is suspended, and Pro Tools posts a warning dialog, allowing you to either return to Pro Tools mode, or save your session and quit Pro Tools.

To put Digi 002 in Stand-alone mode:

1. Press the Standalone switch on the right-hand side of the Digi 002 top panel. Digi 002 displays “Enter Standalone mode? Yes/No.”
2. Press the flashing Channel Select switch under “Yes” to enter Stand-alone mode. Press the switch under “No” to remain in the previous state.

If you enter Stand-alone mode while you are in Pro Tools mode, Pro Tools software will prompt you to either exit Standalone mode or quit Pro Tools. If a Pro Tools session is open, you can save the session before quitting Pro Tools.

To exit Stand-alone mode:

- Press the Standalone switch a second time. Digi 002 goes into Standby mode, or enters Pro Tools mode automatically if Pro Tools software is still running.
Digital Input Format

You can set Digi 002 to receive S/PDIF input at the RCA Input connector or the Optical Input port on the back panel of Digi 002. See “Digital Audio Connections” on page 63 for details on S/PDIF input format.

In Stand-alone mode, the RCA and Optical ports accept S/PDIF signals at sample rates up to 48 kHz.

Digital Clock Source

When you connect an external digital source, you can set Digi 002 to synchronize to external Word Clock (the clock signal coming from the device) or internal Word Clock (generated by Digi 002). In most cases, such as with DAT decks, you will use external clock.

To change the clock source for the digital inputs on Inputs 5–6:

1. In Stand-alone mode, press the Utility (F1) switch.
2. Press the illuminated Channel Select switch under Pref.
3. Press the illuminated Channel Select switch under WClk (Word Clock).
4. Press the illuminated Channel Select switch repeatedly to toggle the clock source to Internal or S/PDIF (external).
5. Press the Escape switch to exit SPDF preferences.
6. Press the far right-hand Channel Select switch to save the preference settings.
7. Press the Escape (Esc) switch twice to exit Utility mode.

When the Word Clock source is set to S/PDIF (external), the Sample Rate indicator flashes to indicate that no clock signal is present, or that Digi 002 is not receiving valid clock signal. The Sample Rate indicator lights solid to indicate Digi 002 is receiving valid clock signal.

Digital Input Connectors (back panel)

To change the digital input format for Inputs 5–6:

1. In Stand-alone mode, press the Utility (F1) switch.
2. Press the illuminated Channel Select switch under Pref.
3. Press the illuminated Channel Select switch under SPDF (S/PDIF).
4. Press the illuminated Channel Select switch repeatedly to toggle the digital format to RCA or Optical.
5. Press the Escape (Esc) switch to exit SPDF preferences.
6. Press the far right-hand Channel Select switch to save the preference settings.
7. Press the Escape (Esc) switch twice to exit Utility mode.

⚠️ Only one S/PDIF input pair can be used at a time. For example, if you use the optical input for S/PDIF data, you cannot use the RCA inputs.
Digital Outputs

The output configuration of Digi 002 in Stand-alone mode depends on the digital output format chosen in the S/PDIF preference setting. (This is the same setting used to configure the digital input format.)

S/PDIF Outputs

In Stand-alone mode, the S/PDIF outputs on the back panel of Digi 002 mirror outputs 1–2 at all times. If RCA is chosen in the S/PDIF preferences, only the RCA S/PDIF connector is active. If Optical is chosen in the S/PDIF preferences, both the RCA and Optical S/PDIF connectors are active.

If Optical is chosen in the S/PDIF preferences, only Main Outputs 1–2 are mirrored in the Optical Output port.

ADAT Optical Outputs

In Stand-alone mode, if RCA is chosen in the S/PDIF preferences, all 8 Input channels are passed directly to the ADAT Optical Output port, pre-fader and pre-effects. This allows you to route input signals directly to an ADAT device and record raw input data on all 8 channels.

To change the digital output format:

1. In Stand-alone mode, press F1 (Utility).
2. Press the illuminated Channel Select switch under Pref.
3. Press the illuminated Channel Select switch under SPDF (S/PDIF).
4. Press the illuminated Channel Select switch repeatedly to toggle the digital format to RCA or Optical.
5. Press the Escape (Esc) switch to exit SPDF preferences.
6. Press the far right-hand Channel Select switch to save the preference settings.
7. Press the Escape (Esc) switch twice to exit Utility mode.

Views in Stand-Alone Mode

In Stand-alone mode, Digi 002 can display the mixer controls in several views.

Home View

Home View is the default mixer view that you see when you first enter Stand-alone mode. This view is actually the same as Console View with the Pan controls displayed on the Rotary Encoders, and channel names on the Channel Scribble Strips.

To put Digi 002 in Stand-alone Home View:

- In Stand-alone mode, press the Pan switch in the upper left-hand corner of the Console View area.
**Console View**

Console View lets you toggle the Digi 002 to display either the pan position controls or the send controls for each channel.

**Pan View** This is the default mixer view that appears when you first enter Stand-alone mode. In Pan View, the faders control Input channel volume and the rotary encoders control pan position.

In this view, the Channel Scribble strips show the channel names. Channel names can be changed in this view. (See “Naming Channels” on page 103.)

**Send View** This view displays the send level controls for each track on the rotary encoders. In Send View, the faders continue to control Input channel volume.

In Send view, the Channel Scribble Strips show the names associated with each send position (Send A=Dly, Send B=Rvrb, Send C=Snd C, Send D=Snd D in Stand-alone mode) across all channel strips.

**To display send level controls for all channels:**

1. In Stand-alone mode, press the Send switch in the upper left-hand corner of the Console View area.
2. Press any of the Send Position switches (A–D) to display the levels for the corresponding send in the rotary encoders. (In Stand-alone mode, the switch for Send E is inactive.)

**To put Digi 002 into Master Fader View:**

1. In Stand-alone mode, press the Master Fader switch to the left of the Navigation and Transport controls.

**Master Fader View**

Master Fader View displays 5 channels in the Digi 002 channel strip area. The Master Faders and Effects Returns appear, with the Master Faders on the right.

**Master Faders** The left and right Master Faders control the output level to Main Outputs 1–2 on the back panel of Digi 002.

**Reverb Returns** These are the left and right returns for Send B, the internal Reverb effect. The amount of reverb effect in the mix output can be controlled with these faders.

**Delay Return** This is a mono return for Send A, the internal Delay effect. The fader controls the amount of delay effect, and the rotary encoder controls its pan position in the mix output.
Reverb and Delay Mute

You can mute the Reverb and Delay effect returns by pressing the Mute switch on the respective channel while in Master Fader View. This allows you to audition the source tracks with the effects temporarily removed.

Reverb and Delay Solo Safe

In Stand-alone mode, the Reverb and Delay returns have a Solo Safe feature. If any input channel (1–8) has a send assigned to the Reverb or Delay and the solo switch is pressed on an input channel, the Reverb and Delay effect returns are not muted, and the effect can still be heard. You can disable the Solo Safe feature by changing the Solo preference setting.

To change the Solo Safe preference:

1. In Stand-alone mode, press F1 (Utility).
2. Press the illuminated Channel Select switch under Pref.
3. Press the illuminated Channel Select switch under Solo.
4. Press the illuminated Channel Select switch repeatedly to toggle the Solo Safe feature On or Off.
5. Press the Escape switch to exit Solo Safe preferences.
6. Press the far right-hand Channel Select switch to save the preference settings.
7. Press the Escape switch twice to exit Utility mode.

Channel Strip Controls

In Console View, each of the 8 channel strips on Digi 002 controls its corresponding input.
Channel Name

The name of each channel appears in the Channel Scribble strips. If you move a fader or rotary encoder, the scribble strip temporarily shows the volume level or pan position. You can rename each of the input channels. (See “Naming Channels” on page 103.)

Encoder/Meter LED Ring

**Encoder Mode** In normal mode (when the “L” and “R” Encoder/Meter indicators are lit), the LED rings above the rotary encoders indicate one of the following:
- In Pan View (or Home View), the LED rings indicate channel pan position.
- In Send View, the LED rings indicate the level for the selected send (A–D) for each channel.
- In Master Fader View, the Delay Return LED ring shows pan position. (No other Rotary Encoders are active in this view.)
- In Channel View, the LED rings display EQ, Compressor, or Pan/Send information.

**Meter Mode** When you press the Encoder/Meter mode switch to the right of the Channel View area so the Meter LED is lit, the LED rings act as meters in the following ways:
- In Pan View and Send View, the LED rings act as post-fader meters for each input channel.
- In Master Fader View, the LED rings act as post-fader meters for the effect return and Master Fader channels.
- When viewing EQ controls in the Channel View area, the LED rings act as post-fader meters for each input channel.
- When viewing compressor controls in the Channel View area, the LED rings act as input, output, and gain reduction meters for the displayed compressor.

Channel Volume Fader

The volume of each input is controlled by its corresponding channel fader.

Pan

The pan position of each input on the stereo output bus is controlled by its corresponding rotary encoder when Digi 002 is in Pan View.

Solo and Mute

The solo and mute status of each channel are controlled by the corresponding switches on each channel strip. In Stand-alone mode, the Solo switches behave in latched fashion, allowing more than one channel to be soloed at the same time.

Channel Select Switch

Depending on the current view, the Channel Select switch performs a variety of functions. In Pan/Send View, this switch toggles the corresponding send between pre- and post-fader operation. In Channel View, you press this switch to select a channel and display the controls for any of the internal effects on Digi 002.

Naming Channels

In Stand-alone mode, you can name the input channels so that the name appears in each channel’s scribble strip. (The names of the Master Fader and Effect Return channels cannot be changed.)

To change the name of an input channel:

1. If Digi 002 is not in Home View, press the Pan switch in the upper left-hand corner of the Console View area to return the unit to Home View.
2 Press F2 (Naming). The Channel Selector switches flash on channels 2–8 and a cursor appears beneath the first character in the Scribble Strip of channel 1. The Channel Select switch below channel 1 lights solid to indicate that its name is being edited.

3 Turn the Rotary Encoder for the first channel to select the first character. (Available characters include uppercase and lowercase letters, numerals, and symbols.)

4 Press the Left and Right Arrow keys in the Navigation Section of Digi 002 to move the cursor left and right in the Scribble Strip display.

5 When you are finished naming the first channel, you can press the Channel Select switch or move the Rotary Encoder for another channel to edit its name.

6 When you are finished naming channels, press the Escape switch or F2 again to return to Home View.

The new channel names are retained in Stand-alone mode as long as Digi 002 remains powered on.

💡 To save the channel names for recall at a later time, you can store the names as part of a Snapshot. See “Storing Snapshots” on page 110.

Channel View

Channel View lets you display the controls for the internal EQ and Dynamics effects on each channel, and also offers a way to view the all pan and send controls on a single channel.

EQ

Each Input channel offers a dedicated 3-band EQ, accessible from EQ switch in the Channel View area.

To display the EQ controls for a track:

1 In Stand-alone mode, press the EQ switch in the Channel View area.

2 Select a channel whose EQ controls you want to display by pressing its Channel Select switch. The Display Scribble Strips show “EQ” and the number of the selected channel.

Digi 002 displays the EQ controls across the Channel Scribble Strips.

See “EQ Controls” on page 106 for more information on working with EQ effects.

Dynamics

Input channels 1–4 offer a dedicated compressor, accessible from the Dynamics switch in the Channel View area.

To display the compressor controls for a track:

1 In Stand-alone mode, press the Dynamics switch in the Channel View area.

2 Select from channels 1–4 the channel whose Dynamics controls you want to display by pressing its Channel Select switch.

Digi 002 displays the compressor controls across the Channel Scribble Strips. The Display Scribble Strips show “Dyn” and the number of the selected channel.

See “Dynamics Controls” on page 107 for more information on working with Dynamics effects.
Pan/Send

The Pan/Send view allows you to view the pan position and the controls for all of the sends on a selected track across all the Channel Scribble Strips.

To display the pan and send controls for a track:

1. In Stand-alone mode, press the Pan/Send switch in the Channel View area.

2. Select a channel whose Pan and Send controls you want to display by pressing its Channel Select switch. The Display Scribble Strips show “P/S” and the number of the selected channel.

Channel Scribble Strip 1 and the first rotary encoder show track pan position for the selected channel.

Channel Scribble Strips 3–6 show the names and their rotary encoders control the levels for all four sends on that track. (Channel Scribble Strips 2, 7 and 8 are inactive.)

When you are displaying sends in Pan/Send view, the Channel Select switches toggles the send between pre- and post-fader operation.

Displaying Parameter Values

The default view for channels, inserts in sends shows the name of the control in the Channel Scribble Strips, and the control’s numerical value is shown only when the control is touched or moved.

By pressing the Command switch and the Display mode switch in tandem, you can change the default view to the numerical value of a control rather than its name.

To revert to the default display, press the Command switch and the Display mode switch a second time.

In addition, pressing the Command switch in tandem with the Display mode switch allows you to set channels to display numerical parameter values by default, rather than control names. For example, in Pan view, when you press Command + Display, fader volume levels (in dB) are the default display.
Working with Effects

In Channel view, the controls for the Digi 002 EQ and Dynamics effects are displayed across the Channel Scribble Strips.

EQ Controls

To access EQ controls for a track:

1. Press the EQ switch in the Channel View area above the Channel Scribble Strips.
2. Press the Channel Select switch on the channel whose EQ controls you want to display.

The onboard EQ controls are distributed across the Channel Scribble Strips as shown in Table 10. The second row of the table shows the function of the Rotary Encoders, and the bottom row of the table shows the function of the Channel Select switches in this view.

To bypass EQ controls for a track:

1. Press the EQ switch in the Channel View area above the Channel Scribble Strips.
2. Press the Channel Select switch on the channel whose EQ controls you want to bypass.
3. Press the Master Bypass switch while in Channel View. The switch flashes to indicate that the displayed EQ is currently bypassed.

Table 10. EQ controls in Digi 002 Stand-alone mode

<table>
<thead>
<tr>
<th>Display</th>
<th>Inpt</th>
<th>&gt; F or ¬F</th>
<th>&gt; G or ¬G</th>
<th>^ F</th>
<th>^ Q</th>
<th>^ G</th>
<th>&lt; F or ¬ F</th>
<th>&lt; G or ¬ G</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary Encoder</td>
<td>Input Gain</td>
<td>Low Shelf Frequency or High Pass Frequency</td>
<td>Low Shelf Gain</td>
<td>Peak Frequency</td>
<td>Peak Q</td>
<td>Peak Gain</td>
<td>High Shelf Frequency or Low Pass Frequency</td>
<td>High Shelf Gain</td>
</tr>
<tr>
<td>Channel Select</td>
<td>Toggle between filters</td>
<td>Bypass Low Band</td>
<td>Bypass Mid-Band</td>
<td>Toggle between filters</td>
<td>Bypass High Band</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Dynamics Controls**

**To access Dynamics controls for a track:**
1. Press the Dynamics switch in the Channel View area above the Channel Scribble Strips.
2. Press the Channel Select switch on the channel whose Dynamics controls you want to display.

The onboard compressor controls are distributed across the Channel Scribble Strips as shown in Table 11. The second row of the table shows the function of the Rotary Encoders, and the bottom row of the table shows the function of the Channel Select switches in this view.

3. When you are finished setting the Dynamics controls, return to Home View by pressing the Pan switch in the Console View area.

**To bypass Dynamics controls for a track:**
1. Press the Dynamics switch in the Channel View area above the Channel Scribble Strips.
2. Press the Channel Select switch on the channel whose Dynamics controls you want to bypass.
3. Press the Master Bypass switch. The switch flashes to indicate that the displayed compressor is currently bypassed.

---

**Table 11. Compressor controls in Digi 002 Stand-alone mode**

<table>
<thead>
<tr>
<th>Display</th>
<th>Inpt</th>
<th>Thsh</th>
<th>Rtio</th>
<th>Atck</th>
<th>Rels</th>
<th>Knee</th>
<th>Phas</th>
<th>Outp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary Encoder</td>
<td>Input Gain</td>
<td>Threshold</td>
<td>Compression Ratio</td>
<td>Attack Time</td>
<td>Release Time</td>
<td>Knee Type</td>
<td>Phase Invert</td>
<td>Output Gain</td>
</tr>
<tr>
<td>Channel Select</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Toggle Hard and Soft Knee</td>
<td>Toggle Normal and Invert</td>
<td></td>
</tr>
</tbody>
</table>
**Working with Sends**

In Stand-alone mode, each Input channel has four fixed sends, with the first two dedicated to the internal Delay and Reverb processing of Digi 002.

**To display and edit the sends to the Delay:**

1. Press the Send switch in the upper left-hand corner of the Digi 002 unit, in the Console View area.
2. Press the Send A switch (located immediately below the Send switch you just pressed). The rotary encoders show the levels for the corresponding sends on each track.
3. Adjust the rotary encoders as desired to send signal to the onboard Delay.
4. Press the Master Fader switch, located to the left of the Navigation and Transport section. The return track for Send A is named Dly.
5. Adjust the fader volume and pan position for the return track.
6. Press the Master Fader switch again to return to the previous view, or press the Pan switch to return to Home View.

**To display and edit the sends to the Reverb:**

1. Press the Send switch in the upper left-hand corner of the Digi 002 unit, in the Console View area.
2. Press the Send B switch. The rotary encoders show the levels for the corresponding sends on each track.
3. Adjust the rotary encoders as desired to send signal to the onboard Reverb.
4. Press the Master Fader switch, located to the left of the Navigation and Transport section. The stereo return tracks for Send B are named RvbL and RvbR.
5. Adjust the fader volume for the return tracks.
6. Press the Master Fader switch again to return to the previous view, or press the Pan switch to return to Home View.
Delay Controls

To access the controls for the onboard Delay:
1. Press the Master Fader switch.
2. Press the Channel Select switch on the Delay return channel.

The onboard Delay controls are distributed across the Channel Scribble Strips as shown in Table 12. The first row of the table shows the function of the Rotary Encoders, and the bottom row of the table shows the function of the Channel Select switches in this view.

3. When you are finished setting the Delay controls, press the Escape key to return to the Master Fader view.

<table>
<thead>
<tr>
<th>Display</th>
<th>Time</th>
<th>Fdbak</th>
<th>LPF</th>
<th>D ——&gt; R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary Encoder</td>
<td>Delay Time</td>
<td>Feedback</td>
<td>Low-pass Filter</td>
<td>Delay Send to Reverb</td>
</tr>
<tr>
<td>Channel Select</td>
<td></td>
<td></td>
<td></td>
<td>Pre/Post</td>
</tr>
</tbody>
</table>

Reverb Controls

To access the controls for the onboard Reverb:
1. Press the Master Fader switch.
2. Press the Channel Select switch on either of the Reverb return channels.

The onboard Reverb controls are distributed across the Channel Scribble Strips as shown in Table 13. The table shows the function of the Rotary Encoders in this view.

3. When you are finished setting the Reverb controls, press the Escape key to return to the Master Fader view.

<table>
<thead>
<tr>
<th>Display</th>
<th>Room</th>
<th>PDly</th>
<th>LPF</th>
<th>Smer</th>
<th>Damp</th>
<th>Diff</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary Encoder</td>
<td>Room Type</td>
<td>Pre-Delay Time</td>
<td>Low-Pass Filter</td>
<td>Smear</td>
<td>Damping</td>
<td>Diffusion</td>
<td>Reverb Decay Time</td>
</tr>
</tbody>
</table>

Table 12. Delay controls in Digi 002 Stand-alone mode

Table 13. Reverb controls in Digi 002 Stand-alone mode
Storing Snapshots

Digi 002 allows you to store up to 24 stand-alone mix configurations and recall them at any time. You can use snapshots to create mix templates or to capture a mix in progress.

A 25th mix configuration, containing stand-alone system defaults, can be recalled, but cannot be modified or renamed.

Snapshots store the following information for each input channel:
- Channel name
- Channel fader position
- Channel pan position
- EQ and compressor settings
- Send levels

To store a snapshot of a mix configuration:
1. Arrange mixer controls, name channels, and set effects controls as desired.
2. Return to Home View by pressing the Pan switch in the upper left-hand corner of the Console View area.
3. Press F3 (Snapshot).
4. Press the Channel Select switch under Save.
5. Turn the Rotary Encoder under the snapshot number to set the number (1–24).
6. Press the Left and Right Arrow keys in the Navigation Section of Digi 002 to move the cursor in the Scribble Strip display.
7. If you want to rename the snapshot, press the Left and Right Arrow keys in the Navigation Section, and turn the Rotary Encoder under the snapshot number to change each character in the snapshot name.
8. Press the flashing Channel Select switch to save the snapshot, or press the Escape switch twice to cancel the operation and return to Home View.

To recall a snapshot:
1. Return to Home View by pressing the Pan switch in the upper left-hand corner of the Console View area.
2. Press F3 (Snapshot).
3. Press the Channel Select switch under Load.
4. Turn the Rotary Encoder under the snapshot number to recall the desired snapshot. (Snapshot #25 returns Digi 002 to its default settings.)
5. Press the flashing Channel Select switch to load the snapshot, or press the Escape switch twice to cancel the operation and return to Home View.
When installing Pro Tools on Windows XP, there are many system variables that affect performance. If you have followed all the Windows configuration instructions in Chapter 2, “Windows Configuration” and are still experiencing problems, try the following troubleshooting suggestions.

Troubleshooting

Blue Screen at Startup

If, after installing Pro Tools and QuickTime, your computer crashes with a blue screen, do the following:

- Use Add/Remove Programs to uninstall Pro Tools.
- Use Add/Remove Programs to uninstall QuickTime.
- Repeat the installation instructions in “Installing Pro Tools LE” on page 11.

Advanced Settings

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

Disabling Network Cards

If applicable, disable any networking cards (other than a 1394 “FireWire” card that you might use to connect an external drive to your system).

To disable a network card:

1. Right-click My Computer and choose Manage.
2. Under System Tools, select Device Manager.
3. In the Device Manager window, double-click Network adapters, then double-click the Network Adapter card you want to disable.
4. Under the General tab, choose “Do not use this device (disable)” from the Device Usage pop-up menu, and click OK.
5. Close the Computer Management window.

Norton Ghost is highly recommended, as it lets you save your system in a working state and easily revert to that state should you accidentally disable anything that your computer needs.

For more information on Ghost, visit the Symantec Web site (www.symantec.com)
Processor Scheduling

To Adjust Processor Scheduling Performance:
1. Choose Start > Control Panel.
2. Launch System.
3. Click the Advanced tab.
4. Under the Performance section, click the Settings button.
5. Select the Advanced tab.
6. Under the Processor scheduling section, select the “Adjust for best performance of background services” option.
7. Under the Memory Usage section, select the System cache option.
8. Click OK twice. You will need to restart your computer for the changes to take effect.

Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools LE. Some startup applications may be consuming unnecessary CPU resources, and should be turned off.

If you disable any of the following startup items, do so carefully:
- Portable media serial number (required for applications that utilize a copy protection key)
- Plug and play
- Event log
- Cryptographic services
- DHCP Client, TCP/IP Net BIOS, and other networking-related items (unless the computer has no network or internet connection, in which case these items can be disabled)

Norton Ghost is highly recommended, as it lets you save your system in a working state and easily revert to that state should you accidentally disable anything that your computer needs.

For more information on Ghost, visit the Symantec Web site (www.symantec.com)

To Disable System Startup Items:

1. From the Start menu, choose Run.
2. Type “msconfig” and click OK. The System Configuration Utility opens.
3. Under the General tab, choose Selective Startup.
4. Deselect Load Startup Items and click OK.
5. Click Restart to restart the computer.
6. After restarting your computer, a System Configuration message dialog is displayed. Check to see if Pro Tools performance has increased before you deselect the “don’t show this message again” option. If performance has not changed, run “msconfig” and return your computer Selective Startup back to Normal Startup. Alternatively, try disabling start up items and non-essential processes individually.
Appendix B: Digidesign ASIO Driver (Windows Only)

Introduction

The Digidesign ASIO Driver is a single-client multichannel sound driver that allows third-party audio programs that support the ASIO standard to record and play back through the following Digidesign audio interfaces:

- Pro Tools|HD audio interfaces
- Digi 002
- Digi 002 Rack
- Mbox

Full-duplex playback of 24- and 16-bit audio are supported at sample rates up to 96 kHz, depending on your Digidesign hardware and ASIO program used.

The Digidesign ASIO Driver will provide up to 18 channels of input and output, depending on your Pro Tools hardware:

- Up to 8 channels of input and output with Pro Tools|HD systems
- Up to 18 channels of input and output with Digi 002 and Digi 002 Rack
- Up to 2 channels of input and output with Mbox

⚠️ The ASIO Driver is not multi-client. Only one application at a time can use the ASIO Driver. Be sure to disable the Windows system sounds. It is also recommended that you use a separate sound card for games or other general work.

💡 Check the Digidesign Web site (www.digidesign.com) for the latest third-party drivers for Pro Tools hardware, as well as current known issues.

Compatible Software

This version of Digidesign ASIO Driver can be used on Digidesign-qualified Pro Tools systems running on Windows XP.

💡 To use Digidesign ASIO Driver without Pro Tools, use the stand-alone version of the Digidesign ASIO Driver. The stand-alone version of Digidesign ASIO Driver is available on the Digidesign Web site (www.digidesign.com)

For a list of ASIO Driver-compatible software, see the compatibility page of the Digidesign Web site (www.digidesign.com/compato).

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.
For a list of Digidesign hardware systems, Digidesign-qualified computers, operating systems, and devices, and Digidesign-qualified third-party ASIO-compatible programs, refer to the compatibility page of the Digidesign Web site (www.digidesign.com/compato).

## Installing the ASIO Driver

Digidesign ASIO Driver is automatically installed when you install Pro Tools.

To use Digidesign ASIO Driver without Pro Tools, use the stand-alone version of the Digidesign ASIO Driver. The stand-alone version of Digidesign ASIO Driver is available on the Digidesign Web site (www.digidesign.com)

## Removing the ASIO Driver

If you need to remove the ASIO Driver from your computer, complete the following steps.

**To remove the ASIO Driver:**

1. Click Start.
2. Click Control Panel.
3. Double-click Add or Remove Programs.
4. From the Currently installed programs list, select Digidesign Pro Tools.
5. Click the Change/Remove button.
6. Choose the Modify button.
7. Click Next.
8. Uncheck the ASIO Driver box.
9. Click Next.
10. When removal is complete, close the Add or Remove Programs window.

## Configuring ASIO Driver Settings

Configuring ASIO Driver settings is done in your third party ASIO program. See your program’s documentation. For example, with Propellerhead Reason, click on the ASIO Control Panel.

### Setup Example, using Propellerhead Reason

### ASIO Driver Control Panel

From the ASIO Driver Control Panel, you can configure the ASIO Driver for your Pro Tools system.
The Digidesign ASIO Driver Control Panel cannot be accessed under the following circumstances:

- When Pro Tools is running.
- When playing or recording in an audio program that does not support the ASIO Driver.
- When using a third-party audio program that has an option to keep the ASIO Driver “open” even when you are not playing or recording. (You must close the audio program before you can open the ASIO Driver Control Panel.)

**Buffer Size Control**

When you play a file from a client audio program, the client program divides the file into little chunks (buffers) and sends each of these to the ASIO Driver. The ASIO Driver copies the client program’s buffers to your Digidesign hardware’s own buffers in a double-buffering scheme. The Buffer Size control in this dialog lets you set the size of each of the two buffers the ASIO Driver uses on Digidesign hardware. You may select from the following buffer sizes (depending on your Digidesign hardware):

- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

Small buffers have the advantage of low latency in the record monitor path. (Latency is the time delay between a signal entering the audio inputs and leaving the outputs during recording.)

Larger buffers have the advantage of making the Digidesign ASIO Driver more immune to audio dropouts during playback and recording.

In some ASIO-compatible audio programs, performing various tasks will interrupt the ASIO Driver and may result in clicks and pops in audio playback or recording. Choosing medium or large buffers (such as 256, 512, or 1024) can help alleviate this problem.

Changing the Buffer Size for the ASIO Driver does not affect the H/W Buffer Size settings in the Pro Tools Playback Engine dialog.

**Device**

The Device Type will always be set to your installed Pro Tools hardware.

**Advanced Button**

The Advanced button opens the Hardware Setup dialog for the Digidesign hardware that you are using.
Introduction

The Digidesign WaveDriver is a single-client, multichannel sound driver that allows third-party audio programs that support the WaveDriver MME (Multimedia Extensions) standard to play back through the following Digidesign audio interfaces:

- Pro Tools|HD audio interfaces
- Digi 002
- Digi 002 Rack
- Mbox

Playback of 24- and 16-bit audio are supported at sample rates of up to 48 kHz, as supported by the hardware and WaveDriver program used.

The Digidesign WaveDriver will provide 2 channels of output.

⚠️ The WaveDriver is not multi-client. Only one application at a time can use the WaveDriver. Be sure to disable the Windows system sounds. It is also recommended that you use a separate sound card for games or other general work. For third-party soft-synthesizer and samplers, use the Digidesign ASIO Driver (refer to the ASIO Driver Usage Guide).

Compatibility

This version of Digidesign WaveDriver can be used on Digidesign-qualified Pro Tools systems running on Windows XP.

💡 To use Digidesign WaveDriver without Pro Tools, use the stand-alone version of the Digidesign WaveDriver. The stand-alone version of Digidesign WaveDriver is available on the Digidesign Web site (www.digidesign.com)

Compatible Software

For a list of WaveDriver-compatible software, see the compatibility page of the Digidesign Web site (www.digidesign.com/compato).

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.
For a list of Digidesign hardware systems, Digidesign-qualified computers, operating systems, and devices, and Digidesign-qualified third-party WaveDriver-compatible programs, see the compatibility page of the Digidesign Web site (www.digidesign.com/compato).

### Installing the WaveDriver

Digidesign WaveDriver is automatically installed when you install Pro Tools.

1. To use Digidesign WaveDriver without Pro Tools, use the stand-alone version of the Digidesign WaveDriver. The stand-alone version of Digidesign WaveDriver is available on the Digidesign Web site (www.digidesign.com)

### Removing the WaveDriver

If you need to remove the WaveDriver from your computer, complete the following steps.

1. Click Start.
2. Click Control Panel.
3. Double-click Add or Remove Programs.
4. From the Currently installed programs list, select Digidesign Pro Tools.
5. Click the Change/Remove button.
6. Choose the Modify button.
7. Click Next.
8. Uncheck the WaveDriver box.
9. Click Next.
10. When removal is complete, close the Add or Remove Programs window.

### Configuring WaveDriver for QuickTime Player (Required for Using iTunes)

In order to let Digidesign hardware play back through iTunes for Windows, you must configure WaveDriver in the waveOut option of the QuickTime Player SoundOut settings to waveOut.

To configure WaveDriver as the iTunes default device:

1. Close all WaveDriver third-party applications (including iTunes).
2. Choose Start > Programs > QuickTime > QuickTime Player.
3. In QuickTime Player, choose Edit > Preferences > QuickTime Preferences.
4. From the pop-up menu, choose Sound Out.
5. From the Choose a device for playback pop-up menu, select the waveOut option (and the name of your Digidesign device, if any).
6. Close QuickTime Player.
7. Re-launch iTunes.

You may also need to add iTunes to the WaveDriver Opt-In list. See “Adding Third Party Applications to the WaveDriver Opt-In List” on page 119.
Configuring WaveDriver for Windows Media Player and Other Third-Party WaveDriver Programs

WaveDriver is configured in the Sounds and Audio Devices Control Panel (for programs that use the Windows Sound Playback Default Device, such as Windows Media Player), or as a preference for third-party WaveDriver programs.

To configure WaveDriver as the Windows Sound Playback Default Device (for example, for Windows Media Player):

1. Open the Sounds and Audio Devices Control Panel.
2. Click the Audio tab.
3. Select the Digidesign audio interface in the Sound Playback default device lists.
4. Close the Control Panel. When you run Windows Media Player, it automatically output to your Digidesign hardware.

You may also need to add your third party WaveDriver program to the WaveDriver Opt-In list. See “Adding Third Party Applications to the WaveDriver Opt-In List” on page 119.

Modifying the Digidesign WaveDriver Opt-In list requires editing the Windows System Registry. Because editing the Windows Registry is dangerous, and can result in problems if not done correctly, make sure to carefully follow the instructions for adding and removing applications.

To configure WaveDriver for a third party WaveDriver application:

- In the third-party program, select the Digidesign audio interface as the preference for your playback hardware. Refer to your program’s documentation.

You may also need to add your third party WaveDriver program to the WaveDriver Opt-In list. See “Adding Third Party Applications to the WaveDriver Opt-In List” on page 119.

Adding Third Party Applications to the WaveDriver Opt-In List

The Digidesign WaveDriver uses an Opt-In list to control third party application access to the Digidesign hardware. Some third party audio applications may not work with the WaveDriver unless they are included in this Opt-In list.

For the latest instructions for adding and removing applications to the WaveDriver Opt-In list, refer to the Digidesign Web site (http://answerbase.digidesign.com/detail.cfm?DID=27424).

You may also need to add your third party WaveDriver program to the WaveDriver Opt-In list. See “Adding Third Party Applications to the WaveDriver Opt-In List” on page 119.

Appendix C: Digidesign WaveDriver (Windows Only) 119
Appendix D: Digidesign CoreAudio Driver (Macintosh Only)

Introduction

The Digidesign CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio compatible applications to record and play back through the following Digidesign audio interfaces:

- Pro Tools|HD audio interfaces
- Digi 002
- Digi 002 Rack
- Mbox

Full-duplex recording and playback of 24-bit audio is supported at sample rates up to 96 kHz, depending on your Digidesign hardware and CoreAudio client application.

The Digidesign CoreAudio Driver will provide up to 18 channels of input and output, depending on your Pro Tools hardware:

- Up to 8 channels of input and output with Pro Tools|HD systems
- Up to 18 channels of input and output with Digi 002 and Digi 002 Rack
- Up to 2 channels of input and output with Mbox

⚠️ For Pro Tools TDM systems with more than one card and multiple I/Os, only the primary I/O connected to the first (core) card can be used with CoreAudio.

💡 Check the Digidesign Web site (www.digidesign.com) for the latest third-party drivers for Pro Tools hardware, as well as current known issues.
What are the Limitations of the Digidesign CoreAudio Driver?

The Digidesign CoreAudio Driver has the following limitations:

◆ Pro Tools is not a CoreAudio application and therefore requires exclusive access to Digidesign hardware. You cannot use CoreAudio applications and Pro Tools at the same time. To use Pro Tools, make sure you quit any CoreAudio applications before starting Pro Tools. To use a CoreAudio application, make sure you quit Pro Tools before starting any CoreAudio application.

◆ The Digidesign CoreAudio Driver cannot be used to preview sound files from the Finder. When a sound file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you audition the sound file. The sound will always play back through the Macintosh’s built-in audio controller (through the Macintosh’s speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, and can use the Digidesign CoreAudio Driver for playback.

◆ The Digidesign CoreAudio Driver cannot be used for playback of System Sounds.

Compatible Software

For a list of CoreAudio Driver-compatible software, refer to the Digidesign Web site (www.digidesign.com/compato).

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved.

For a list of Digidesign hardware systems, Digidesign-qualified computers, operating systems, and devices, and Digidesign-qualified third-party CoreAudio-compatible applications, refer to the compatibility page of the Digidesign Web site (www.digidesign.com/compato).

Installing the Digidesign CoreAudio Driver

The CoreAudio Driver is installed by default when you install Pro Tools.

Stand-Alone CoreAudio Driver Installer

This version of Digidesign CoreAudio Driver can be installed on Digidesign-qualified Pro Tools systems running on Macintosh (for example, if the CoreAudio Driver was uninstalled), or it can be installed as a stand-alone driver on Macintosh systems that do not have Pro Tools installed.

For detailed information on installing and configuring CoreAudio Driver on systems with or without Pro Tools, see the electronic pdf of the CoreAudio Usage Guide.
Removing the CoreAudio Driver

To uninstall the Digidesign CoreAudio Driver:

1. Power on your system.
2. Do one of the following:
   - On the Pro Tools Installer CD, locate and double-click the Install CoreAudio file.
   - From the Digidesign Web site, download, locate, and double-click the Install CoreAudio file.
3. In the Install CoreAudio window, select Uninstall from the Custom Install pop-up menu.
4. When the uninstall is complete, quit the CoreAudio Installer.

Configuring the Digidesign CoreAudio Driver

You can configure the Digidesign CoreAudio Driver using Digidesign CoreAudio Manager, or from within most third-party CoreAudio-compatible client applications (such as BIAS Peak or Logic Audio). Consult the manufacturer’s documentation for more information.

Some applications (such as Apple’s iTunes or QuickTime Player), also require that you configure either the Apple Sound Preferences or Apple Audio MIDI Setup to use the Digidesign CoreAudio Driver.

Digidesign CoreAudio Manager

Use Digidesign CoreAudio Manager to change the CoreAudio Buffer Size setting, access the Hardware Setup dialog for your Digidesign hardware and control volume and mute for the CoreAudio driver. Digidesign CoreAudio Manager also identifies your Digidesign hardware, the supported number of Input and Output Channels and the number of attached clients (applications).

Digidesign CoreAudio Manager cannot be accessed under the following circumstances:

- When Pro Tools is running
- When another application is using Direct IO (such as the Ableton Live Digi Edition)

The Digidesign CoreAudio Manager application launches automatically when the first client application accesses the CoreAudio driver. You can prevent an application from accessing the CoreAudio driver by holding down the Shift key just before the application would access the CoreAudio driver, typically during launch of the application. Certain applications (such as Apple Mail and iChat), do not access the CoreAudio application until they first play a sound, so you will need to hold down the Shift key just prior to sound playback in order to “opt-out” of using Digidesign hardware for playback.

Figure 11. Digidesign CoreAudio Setup
Buffer Size

You may select from the following buffer sizes (depending on your Digidesign hardware):

- 64 samples
- 128 samples
- 256 samples
- 512 samples
- 1024 samples
- 2048 samples

Small buffers have the advantage of low latency in the record monitor path, but also are more taxing on your computer’s CPU and could contribute to dropouts in your audio during record or playback. (Latency is the time delay between a signal entering the audio inputs and leaving the outputs during recording.)

Larger buffers have the advantage of making the Digidesign CoreAudio Driver more immune to audio dropouts during playback and recording, but can cause a noticeable delay when monitoring your inputs in the recording process. In some CoreAudio-client applications, performing various tasks will interrupt the CoreAudio Driver and may result in clicks and pops in audio playback or recording. Choosing medium or large buffers (such as 512 or 1024) can help alleviate this problem.

Changing the Buffer Size for the Digidesign CoreAudio Driver does not affect the H/W Buffer Size settings in the Pro Tools Playback Engine dialog.

To configure Digidesign CoreAudio Hardware Buffer Size:

1. Launch Digidesign CoreAudio Manager (located in /Applications/Digidesign).
2. From the Buffer Size pop-up menu, select the desired CoreAudio buffer size (in samples). Generally, smaller buffer sizes are preferable. However, if you experience any problems with performance (such as clicks and pops during recording or playback), try increasing the CoreAudio Buffer Size setting. You can also change the buffer size from within the client application if it is the only client attached to the CoreAudio driver. Once two or more clients are active, you will not be able to change the sample rate or the buffer size.

HW Setup Button

The HW Setup button opens the Hardware Setup dialog for your Digidesign hardware. For more information, refer to the Getting Started Guide for your Pro Tools system or the Pro Tools Reference Guide.

To configure Digidesign CoreAudio HW Setup:

1. Launch Digidesign CoreAudio Manager (located in /Applications/Digidesign).
2. Click the HW Setup button to open the Hardware Setup dialog. The HW Setup button will only be available when no clients are using the CoreAudio driver.
3 Configure the Hardware Setup dialog for your Digidesign hardware. If you have more than one audio interface connected to your Pro Tools TDM system, be sure to select and configure only the primary audio interface connected to the core card.

For more information on the Hardware Setup dialog, refer to your Getting Started Guide or the Pro Tools Reference Guide.

4 When you are finished, click OK to close the Hardware Setup dialog.

Prefs Button

The Prefs button opens the Digidesign CoreAudio Manager Preferences dialog for the Manager application. There are several options available for control and configuration of the Manager application. When finished setting these options, click OK to close the Digidesign CoreAudio Manager Preferences windows.

Use D-Control Stereo Routing (L/R to 1/5)

Enable this option to configure the CoreAudio driver to output through the D-Controls standard stereo routing outputs 1 and 5.

Mirror Analog Outs 1 & 2 to Digital Outs (002 Only)

When using Digi 002 or Digi 002 Rack, enable this option to mirror the main outputs through the digital outputs that are selected in the HW Setup panel.

Connect Button

The Connect button is available when the Digidesign CoreAudio Manager is launched and cannot connect with the Digidesign hardware (such as when Pro Tools is launched and the hardware is disconnected or disabled). Before trying to connect, make sure to quit Pro Tools and make sure that your hardware is connected and turned on. You can then click on the Connect button to acquire the hardware.

If any application is launched prior to pressing the Connect button and you want that application to use the CoreAudio driver for playback, you will need to quit and relaunch the application for it to connect properly to the Digidesign CoreAudio Manager.

Quit Button

Use the Quit button to quit the Digidesign CoreAudio Manager. Be sure to quit any client applications before using the Quit button in the Manager. If any applications are currently attached to the Manager application when quitting, you may get an error message indicating that the Digidesign hardware is no longer available. You may have to change the application’s preferences to use different hardware for playback or possibly quit and relaunch the application for proper playback to be resumed.
Configuring the Apple Sound Preferences or Apple Audio MIDI Setup

To use your Digidesign hardware with common CoreAudio-compatible playback applications (such as Apple iTunes or QuickTime Player), you will need to configure either Sound Preferences or Audio MIDI Setup in addition to Digidesign CoreAudio Setup. However, for most CoreAudio-compatible client applications (such as BIAS Peak or Cubase SX) this is unnecessary because you can configure the CoreAudio Buffer Size setting, and input and output channels from within the application.

Apple Sound Preferences

To configure the Apple Sound Preferences:
1. Launch System Preferences (Apple menu > System Preferences).
2. Click Sound.
3. Click the Output tab and select Digidesign HW as the device for sound output.
4. Click the Input tab and select Digidesign HW as the device for sound input.
5. Quit System Preferences.

Apple Audio MIDI Setup

To configure the Apple Audio MIDI Setup:
1. Launch Audio MIDI Setup (located in Home/Applications/Utilities).
2. Select the Audio Devices tab.
3 From the System Settings Default Input pop-up menu, select Digidesign HW.

4 From the System Settings Default Output pop-up menu, select Digidesign HW.

⚠️ Leave System Output and Selected Audio Device set to Built-in audio controller. The Digidesign CoreAudio Driver cannot be used for system sounds.
MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.

Interface Controls

Create This button adds a new instrument to the Instrument Name list.

Delete This button deletes the instrument or instruments selected in the Instrument Name list.

Import This button lets you import an existing MIDI Studio Setup file.

Export This button lets you export the current MIDI Studio Setup file.
Show Duplicate Emulated Ports If you are using a MIDI interface that supports timestamping (such as MIDI I/O), when the Show Duplicate Emulated Outputs option is selected, the MIDI Studio Setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

Instrument List

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument's properties in the Properties section of the window.

Properties Section

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

To define an instrument with MIDI Studio Setup:

2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press enter.

💡 If you do not enter an instrument name, the Instrument Name field will automatically inherit information from the Manufacturer and Model pop-up menu.

4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, choose None.
5. From the Input pop-up menu, choose the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6. From the Output pop-up menu, choose the output port on your MIDI interface that is connected to the MIDI In of your instrument.
7. Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

Instrument Name

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

Manufacturer

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

For more information, see “Patch Name Support” on page 131.
Model

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

For more information, see “Patch Name Support” on page 131.

Input Port

The Input Port pop-up menu displays a list of available MIDI interface input ports. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input Selector.

Output Port

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output Selector.

Send Channels

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

Receive Channels

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

To import MIDI patch names into Pro Tools:

1 Verify the MIDI Device name in the MIDI Studio Setup window (Setups > MIDI Studio Setup).
2 Verify the MIDI track’s output is correctly assigned to the MIDI device.
3 Click the MIDI track’s Program button.

If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input Selector.

If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output Selector.
4. In the Patch Select dialog, click the Change button.

In the Open dialog, navigate to Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

5. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

6. To clear patch names:
   - In the Patch Select dialog, click the Clear button, and click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third party patch librarian and editor software to create your own custom patch names.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.
Appendix F: Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

To configure your MIDI studio in AMS:

1. Launch Audio MIDI Setup (located in Applications/Utilities).
   - or -

2. Click the MIDI Devices tab. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1. Select the external device icon and click Show Info (or double-click the new device icon).

External Device Icon

2. Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

Naming a new MIDI device

AMS refers to one or more files with the suffix “.middev” in the directory Root/Library/Audio/MIDI Devices for Manufacturer and Model names. Pro Tools installs two such files that contain information for many commercially available MIDI devices, “Legacy Devices.middev” and “Digidesign Devices.middev.” If the Manufacturer or Model names for any of your external MIDI devices are not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing any of the current .middev files in any text editor (such asTextEdit).
3 Click the More Properties arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Click OK. The device names you enter appear as MIDI input and output choices in Pro Tools.

To use your own custom icons, you can place TIFF image files in /Library/Audio/MIDI Devices/Generic/Images, and they will appear as choices in the AMS device window.
**Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

**To import MIDI patch names into Pro Tools:**

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Studio” on page 133).

2. Verify the MIDI track’s output is correctly assigned to the MIDI device.

3. Click the MIDI track’s Program button.

4. In the Patch Select dialog, click the Change button.

5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left-hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

**To clear patch names:**

- In the Patch Select dialog, click the Clear button, and click Done.

* MIDI patch name files (.midnam) can be edited in any text editor, or you can use third party patch librarian and editor software to create your own custom patch names.*
The diagram on the following pages shows the basic signal flow of Digi 002 in Stand-alone mode.

The diagram shows the Digi 002 mixer divided into two sections, with the first page showing Input Channels 1–4, the second page showing Input channels 5–8 and the Master Faders, Effect Returns, and Outputs. The two sections share the four send busses (A–D), the main stereo bus (L–R), and the ADAT Optical output bus (ADAT 1–8).

⚠️ This signal flow diagram is not a detailed circuit diagram or wiring schematic. It is intended to provide an overview of the mixer functions of Digi 002 in Stand-alone mode only.
Numerics
32K clusters 18
4-pin FireWire cable 11, 25

A
ADAT
   connecting 66
   recording from Pro Tools LE 83
   recording to Pro Tools LE 83
adjusting Mic/Line input gain 81
analog audio 61
analog devices, connecting 62
analog tape deck, connecting 66
ASIO driver 12, 113
audio
   editing 87
   importing 79
   routing 81, 90
Audio Regions List 76
audio tracks 75, 76
authorization code
   Macintosh 25
   Windows 14
automation 93
   creating 93
   editing 94
Auxiliary Inputs 75, 76, 86, 90

B
Bounce to Disk command 94

C
channel controls
   channel select switch 34
   faders 34
   mute switch 34
   record ready switch 35
   rotary encoders 35
   scribble strip 35
   solo switch 34
channel select switch 34, 103
channel strip controls
   Mute 90
   Pan 90
   Solo 90
   Volume 90
Channel View 33, 38
channels
   naming 103
click 72
Click plug-in
   Accented parameter 72
   Unaccented parameter 72
Clock Source 17, 28
clock source 99
   changing 99
cluster size 18
connecting
   a footswitch 86
   analog devices 62
digital devices 66
   headphones 60
   microphones 62
   MIDI devices 67
   speakers 60
to a mixdown recorder 66
to an ADAT 66
Console View 33, 37
CoreAudio Driver 23, 121
**D**

DAT recorder, connecting 66
defragmenting
   Windows 19
Delay 109
Digi 002
   connecting 10
   top panel 32
   what's included 1
Digi 002 Rack
   connecting 10
   front panel 47
digital 63
digital audio
   ADAT format 63
   S/PDIF format 63
digital devices, connecting 66
Disk Cleanup 19
DMA 8
Dynamics 38
   in Channel View 38, 104
   in Stand-alone mode 96, 97

**E**

Edit mode buttons 87
Edit modes 87
   Grid 87
   selecting 87
   Shuffle 87
   Slip 87
   Spot 87
Edit tools 88
   Grabber 88
   Pencil 88
   Scrubber 88
   Selector 88
   Smart Tool 88
   Trimmer 88
   Zoomer 88
Edit window 70
   editing 87
   editing regions 88
EQ 38
   in Channel View 38, 104
   in Stand-alone mode 96, 97
   external effects devices 63, 64

**F**

fade files 69
Fader Flip 36
faders 34
FAT32 18
FireWire 55
   connecting devices 55
   connection status 49
   footswitch 56

**G**

gain
   adjusting for Mic/Line inputs 81
Grabber tool 88
Grid mode 87

**H**

hard drives
   and Macintosh system drive 30
   and Windows system drive 19
   cluster size 18
   FireWire 55
   formatting 30
   maintenance 19
   storage space for audio 4
   Windows maintenance 19
hardware installation 8
headphones
   connecting 60
headroom 51
Hibernate 9
high-pass filter 82
Home View 33
I
I/O Setup 17, 29
importing audio 79
input controls 42, 48
input levels 81
inputs 42, 48, 53, 96
  alternate inputs 42, 48
  analog 53
  digital 54, 98
  optical 55
  S/PDIF 54, 97
inserts 38
  in Channel View 38
  plug-ins 93

L
latency for recording and monitoring 84
Lightpipe 55
line-level sources, connecting 62
Link indicator 56
Low Latency Monitoring 84

M
MacOpener 13
Master Faders 36, 75, 76, 92
  creating 92
memory locations 78, 79
  defining 78
  recalling 78
Mic/Line high-pass filter 82
microphone 53
microphones, connecting 62
MIDI
  editing 87
  monitoring 86
MIDI click 72
MIDI connections 67
MIDI controls 72, 74
MIDI devices, connecting 67
MIDI Regions List 76
MIDI tracks 75, 76
  recording with footswitch 87
mix automation 93
Mix window 70, 90
mixdown and connecting a recorder 66
mixing 90
modes
  Counter mode 45
  Display mode 44
  Flip mode 36
  Pro Tools mode 31
  Stand-alone mode 31
  Standby 31
  Status Mode 44
modifier keys 43
  Command 43
  Control 43
  Option 43
  Shift 43
monitor controls
  level 43, 49
  mono switch 43, 49
  mute 43, 49
monitoring
  MIDI 86
  monitoring latency 84
  Mute button 90
  mute switch 34
N
navigation controls 40
NTFS 18
O
operating levels 51
outputs
  ADAT Optical 100
  analog 54
  digital 54, 100
  in Stand-alone mode 96, 97
  S/PDIF 100
Pan slider 90
Pan/Send controls 39
in Channel View 39
Pencil tool 88
phantom power 53
playback
  starting and stopping 74
Playback Engine dialog 73
playlists 90
  creating 90
Plug-Ins 39
  in Channel View 39
plug-ins 92
power
  Windows System Standby 9
power amp and speakers, connecting 60
Pro Tools LE
  capabilities 3
  installing, Windows 11
  main windows 70
  software configuration 26
Pro Tools mode 31
Pro Tools Reference Guide 5
Program Change dialog 132, 136
punch-in recording with footswitch 86
QuickPunch recording 86
QuickTime 12
record ready switch 35
recording
  audio 82
  audio tracks with QuickPunch 86
  from ADAT tracks 83
  MIDI 85
  MIDI tracks with footswitch 87
  monitoring latency 84
  to ADAT tracks 83
regions 76
  arranging 89
  creating 76
  editing 88
  trimming 88
returns 91
  creating 91
Reverb 109
rotary encoders 35
rulers 71
Sample Rate 16, 27
sample rate 51
  in Stand-alone mode 96
scribble strip 35
Scrubber tool 88
Selector tool 88
sends 76, 91, 97
  assigning 91
  in Stand-alone mode 96, 108
sends to external effects devices 64
sessions 69
  creating 69
  duplicating 73
  navigating 77
  saving 69, 73
  saving copies of 73
Shuffle mode 87
Slip mode 87
Smart Tool 88
snapshots 110
  recalling 110
  storing 110
Solo button 90
solo safe 102
  disabling 102
solo switch 34
speakers, connecting 60
Spot mode 87
Stand-alone mode 31, 95
  entering 98
Standby mode 31
submixing 91
System settings
  for Windows 8
  system settings 73
  Clock Source 17, 28
  I/O Setup 17, 29
  Sample Rate 16, 27
  System Usage window 74
Index

T
  tempo 71
  setting 71
  tempo events 71
  track height
    changing 78
  tracks
    audio 75, 76
    Auxiliary Inputs 75, 76, 90
    creating 75
    Master Faders 75, 76, 92
    MIDI 75, 76
    playing back audio 83
    playing back MIDI 85
    recording audio 82
    recording MIDI 85
    types 75
  Transport
    MIDI controls 74
    transport controls 40
    Transport window 70, 74
  Trimmer tool 88

V
  views
    Channel View 33, 38, 45, 104
    Console View 33, 37, 44, 101
    Home View 33, 100
    Master Fader View 101
  Volume fader 90

W
  WaveDriver 12
  Windows
    required System settings 8
    System Standby 9
  windows 70
    Edit window 70
    Mix window 70, 90
    Transport window 70, 74
  Windows System Standby 9
  Windows XP
    maintenance 19
  Word Clock 99
  Workspace 70

Z
  zoom controls 41
  Zoom presets 79
    recalling 79
    storing 79
  Zoomer tool 88
  Zooming 78